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Introduction to Legacy HawkSoft 
Help Documentation
Version 5 of the HawkSoft Management System has reached its end of support. The following doc-

uments are an offline copy of the legacy Version 5 online help portal, provided as a courtesy to your 

agency, which has elected to remain on HawkSoft version 5.

Please keep the following in mind as you navigate this help documentation:

 l To prevent issues with size, portability, and navigability, the Version 5 help documentation has 

been split into nine PDF files (including this one). If a help topic contains a link to a different topic 

which does not seem to function properly, it most likely links to a topic contained in a different 

PDF file. In that case, try searching the other PDF files for the topic named in the link.

 l While some topics may mention contacting Product Support for assistance, please note that 
HawkSoft Product Support assistance of any kind is no longer available for this version 
of HawkSoft.

 l While we have done our best to remove any topics relating to online features that are no longer 

functional, this help documentation may still contain references to features which are no longer 

functional due to HawkSoft 5's end of support.

 l Help and training videos are not available in this help documentation. However, you may still 

occasionally see references to help or training videos in this documentation.

Commission Tracking Overview
HawkSoft CMS has the ability to track and report commissionable transactions for agents who are paid 

on a commission basis.  CMS gives agencies the tools to reconcile commission transactions and create 

commission paid reports for the agents and the agency, on a per carrier basis. 



3/5/2026 Copyright © 2015 HawkSoft, Inc., All Rights Reserved. 1857

You must have the Agents commission basis and amounts set up in the User List and the Agency's 

commission configured in Policy Company Setup for CMS to calculate commissions. See Agent Com-

mission Setup and Agency Commission Setup.

 If an agency does not pay agents on a commission basis, no commission setup or tracking is neces-

sary.

 Commission tracking features are not Trust Accounting features and do not integ-
rate with QuickBooks®.

Commission Tracking Setup
Commission Tracking must first be set up for your agency in order for CMS to begin tracking trans-

actions.  This overview lists several articles to  help you set up commission basis with each of your car-

riers and get your agency set up to track and report commissionable transactions for agents who are 

paid on a commission basis.

Commission Tracking Setup Overview

Creating Commission Transactions on a Policy 
When Commission Tracking in HawkSoft CMS is enabled, CMS begins creating and tracking  com-

mission transactions on all policies. Creating a commission transaction on a policy makes it possible 

for CMS to track and calculate the commission for the agency and the producer. 

The following articles explain how a commission transaction is automatically created on a policy in 

CMS, the steps to manually create a commission transaction for commission statements that are not 

imported, and how to modify a transaction on a policy.

             Creating Commission Transactions on a Policy

Reconciling Commission Statements
An important step in tracking commissions is reconciling carrier statements and saving the completed, 

corrected transactions to the policies. These reconciled transactions are used to generate agency and 

agent commission reports. This overview lists several articles to  help you reconcile imported and non-

imported commission statements. 

Reconciling Commission Statements Overview
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Printing Commission Paid Statements
After reconciling commission statements, your agency is able to generate an Agent or Agency Com-

mission Paid Report.  These  Reports summarize the commissions due to each agent and/or the 

agency. An Agent Commission Paid Report  is typically distributed to agents to show a summary of com-

missions paid.

Printing an Agency Paid Statement

Commission Paid Reports
HawkSoft enables you to create a detailed report of all commission transactions for a specified date 

period. From this report, you can review commission transactions, customize the report layout, filter the 

report, and access the client files associated with the transactions. 

Commission Reports

Creating an Agency Unpaid Commission Report

Modifying a Reconciled Commission Transaction
HawkSoft CMS enables you to modify a reconciled commission transaction directly from a policy. This 

includes editing transactions that have already been  included on a commission paid report. 

This article describes the steps to modify a commission transaction directly from a policy. Modifying a 

previously reconciled transaction will change the results of the commission paid report.

Correcting a Reconciled Commission Transaction

Commission Tracking Setup Overview
Commission Tracking must first be set up for your agency in order for CMS to begin tracking trans-

actions.  The following articles will help you set up commission basis with each of your carriers and set 

up your  agency to track and report commissionable transactions for agents who are paid on a com-

mission basis. 



3/5/2026 Copyright © 2015 HawkSoft, Inc., All Rights Reserved. 1859

Enabling Commission Tracking

Enabling Commission Tracking turns on the HawkSoft CMS commission tracking feature that tracks 

and reports on commission transactions as they are created in the database.  This includes trans-

actions created by policy downloads, imported commission statements, receipting and invoicing, as 

well as commission transactions created manually. 

Your agency must have commission tracking enabled for CMS to track commissions for producers.

Enabling Commission Tracking

Agency Commission Setup

HawkSoft CMS  enables you to calculate and track commissions paid to or retained by your agency, 

based on the commission basis  set up for each carrier in CMS.  This article explains how to set up the 

carrier commission basis for your agency.

Agency Commission Setup

Setting Up Carriers with Multiple Commission Schedules

HawkSoft CMS enables you to track commissions for a carrier with multiple commission schedules. 

This article describes the options for setting up multiple commission schedules for your carriers.

Setting Up Carriers with Multiple Commission Schedules

Agent Commission Setup

HawkSoft CMS  calculates and tracks commissions based on the commission basis set up for each 

agent in CMS.   This article explains how to set up the agent commission basis prior to tracking com-

missions.

Agent Commission Setup

Users for Commission and Sales Tracking Only 

CMS enables you to create a user profile as a Commissions and Sales Tracking placeholder within 

CMS. Your agency might need placeholder user profiles for commission    and/or sales tracking pur-

poses only. For example, some agencies create a 'House' user to track clients that are assigned to the 

entire agency within commission     and sales reports. 
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Users marked as Commission and Sales Tracking Only can be assigned to policies as Agents and 

assigned to clients as Producers/CSRs.    These users  can appear in Commission, Advanced, Agency 

Intelligence, and Sales & Retention reports, but  cannot log into CMS.

Commission and Sales Tracking Users

Agent Split Commission Setup

HawkSoft CMS enables you to set up split commissions between two or three producers on a policy. 

To have CMS calculate split commissions, you must create multiple user profiles. Setting up multiple 

user profiles might also be useful for situations when an agent might earn a commission structure that 

is different from their primary commission structure. 

Agent Split Commission Setup

Enabling Commission Tracking

Enabling Commission Tracking turns on the HawkSoft CMS commission tracking feature that tracks 

and reports on commission transactions as they are created in the database.  This includes trans-

actions created by policy downloads, imported commission statements, receipting and invoicing, as 

well as commission transactions created manually. 

Your agency must have commission tracking enabled for CMS to track commissions for producers.

This task is typically performed by an Owner/Administrator, Manager, or Bookkeeper.

Required Permissions:
In order to complete this task, user permissions must be set to include:

Setup > General Configuration

See Setting User Permissions for more information.

To enable commission tracking

 1.  Click the   Settings icon, and then select General Configuration from the main CMS menu 

bar.

The General Configuration dialog opens with the General Settings screen open.

../../../../../Content/Agency Setup/Manage Agency Users/User Permissions.htm
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 2.  Select the Accounting:  Commission Tracking setting.

 3.  Click OK.

Commission tracking is now enabled and CMS will begin creating and tracking commissionable trans-

actions.  Calculations for agency and agent commissions will also be calculated based on percentages 

entered during  Agency Commission Setup  and  Agent Commission Setup.

Related Topics

Commission Tracking Overview

Agency Commission Setup

HawkSoft CMS  enables you to calculate and track commissions paid to or retained by your agency, 

based on the commission basis  set up for each carrier in CMS.  This article explains how to set up the 

carrier commission basis for your agency.

This task is typically performed by an Owner/Administrator or Manager.

Required Permissions:
In order to complete this task, user permissions must be set to include:

Accounting > Edit Carrier Commission Settings
Setup > Policy/Company Setup

See Setting User Permissions for more information.

Setting up agency commissions

Follow the steps below to add the commission basis for a carrier.  This must be done for 

each carrier (each state) and for each policy type that the carrier pays commission for  

(Auto, Boat, Home, MoPro, Commercial).

 1.  Click the   Settings icon, and then select Policy/Company Setup from the main 

CMS menu bar.

 2.  Select the appropriate carrier profile.

 3.  Click Edit.

 4.  Select the Commission tab in the carrier profile.

../../../../../Content/Commission Tracking/Setting Up Commission Tracking/Agent Commission Setup.htm
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 5.  Insert the New and Renewal term Commission Basis using the Basis drop-down 
list.

 l None – No commission is calculated.

 l Agency Bill – Calculates the commission based on the amount in the 
Retained field on an invoice or receipt.  Use this when the agency is retaining 

commission on an invoice or receipt.

If Agency Bill is selected for the New Basis, the Renewal 
field is grayed out but a commission percentage can still 
be entered in the Amount field.

 l Premium Paid – Calculates the commission based on actual premium 
amount paid.

 l Premium Written – Calculates the commission based on the total premium 
amount for new and renewal business, or the pro-rated additional or returned 

premium amount for a cancellation, reinstatement, or endorsement.

 l Flat Fee – Calculates a flat dollar amount for each transaction.

The Flat Fee dollar amount will be calculated for every 
transaction during the New/Renewal term, regardless of 
the type of transaction.

 l Statement Download – The carrier downloads the Direct Bill Commission 
Statement into CMS, and CMS reads the carrier calculations from the down-

loaded file.

When Statement Download is selected for the New Basis, 
it also applies to Renewal. The Amount fields are unavail-
able, since CMS does not calculate agency commissions 
for carriers that offer downloaded statements.

 l Custom Import – The carrier sends commission statements as a spread-
sheet (CSV, XLSX, or XLS) to be imported with the Commission Importer.  

CMS reads the carrier calculations from the imported file.
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When Custom Import is selected for the New Basis, it also 
applies to Renewal. The Amount fields are unavailable, 
since CMS does not calculate agency commissions for 
carriers that offer downloaded statements.

 6.  Enter the commission percentage or flat fee amount in the Percentage 
(%)/Amount field.

 7.  Include Fees: Check this box if CMS should calculate commission on the fees (i.e. 
policy fees).

The commission basis is set up for this carrier. 

 8.  Optional: Enter Agent Commission Exceptions only when the commission paid to 
an agent for this particular company and base policy type is different than the rate 

set in the user’s profile. Setting agent commission exceptions for a user overrides 

the commission set in the user profile. See Agent Commission Setup for more 

information.

Agent commission exceptions

 a.  Click Add.

The Agent Commission dialog opens.

 b.  Select the Agent from the  drop-down list.

 c.  Select the New and Renewal commission basis from the Basis drop-down 
list.

 l None – No commission is calculated.

 l Commission Paid – Calculates the agent's commission as a per-
centage of the commission amount the carrier pays the agency. 

 l Premium Paid – Calculates the commission based on actual premium 
amount paid. This option is not available when the agency commission 

basis is Premium Written.

 l Premium Written – Calculates the commission based on the total 
premium amount for new and renewal business, or the pro-rated addi-

tional or returned premium amount for a cancellation, reinstatement, or 
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endorsement. This option is not available when the agency commission 

basis is Premium Paid.

 l Flat Fee – Calculates a flat dollar amount for each transaction.

The Flat Fee dollar amount will be calculated for 
every transaction during the New/Renewal term, 
regardless of the type of transaction.

 d.  Click OK.

The commission exception has been set and the exception information will appear 

in the Agent Commission Exceptions box.  Repeat steps for other agents as neces-

sary.

 9.  Click Finish to return to the main Policy/Company Setup dialog.

 10.  Select another carrier to set up commissions for, or click Close to exit.

Related Topics
Policy/Company Setup Overview
Setting Up Carriers with Multiple Commission Schedules

Setting Up Carriers with Multiple Commission Schedules

HawkSoft CMS enables you to track commissions for a carrier with multiple commission schedules. 

This article describes the options for setting up multiple commission schedules for your carriers.

Commission schedules are typically set up by an Owner/Administrator, Manager, or Bookkeeper.

This setup does not apply to carriers that download commission statements or send 
spreadsheets that can be imported.  Imported commission statements create the 
commission transaction with the correct percentages.  See the Carrier Download 
List  to check which of your carriers can download commission statements or 
provide spreadsheets that can be imported.

#Policy/Company%20Setup%20Overview
https://hawksoftinc.com/agency-management-system/carrier-downloads
https://hawksoftinc.com/agency-management-system/carrier-downloads
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In this topic:

Most Common Commission Basis Setup Multiple Carrier Profile Setup

Required Permissions:
In order to complete this task, user permissions must be set to include:

Accounting > Edit Carrier Commission Settings
Setup > Policy/Company Setup

See Setting User Permissions for more information.

The most common commission basis setup
HawkSoft Inc. recommends that carriers that have multiple commission schedules be set up   in Poli-

cy/Company Setup using the most commonly earned new and renewal commission basis. See Agency 

Commission Setup for more information.

Example: XYZ Insurance Company has multiple commission schedules set by line of business as lis-
ted below. XYZ most commonly writes Home policies, so they set the Agency Commission percentage 

amount to 12% for new policies and 10% for renewals for this carrier.

Line of Busi-
ness

New %/Amt Renew %/Amt

Home 12% 10%

Renters 10% 8%

Condo 10% 8%

The most common percentage earned is used in the example above. During the reconciliation of the 

commission statement, as you   encounter commission transactions that should be paid at a different 

commission rate,  CMS enables you to edit the calculated commission paid amount on the report  so it 

matches the actual amount on the commission statement. See Modifying Commission Transactions 

During Reconciliation. 

#Most_Common_Commission_Basis_Setup
#Multiple_Carrier_Profile_Setup
../../../../../Content/Agency Setup/Manage Agency Users/User Permissions.htm
#Policy/Company%20Setup%20Overview
#Policy/Company%20Setup%20Overview
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Multiple carrier profile setup
 The alternate method of setting up a carrier with multiple commission schedules is to create duplicate 

carrier profiles. This method is typically used if a carrier has multiple commission schedules and the 

agency writes a significant number of policies with multiple commission structures for the carrier.   The 

separate carrier profiles are configured to have their own commission basis.

Example: XYZ Insurance Company has multiple commission schedules set by line of business, as lis-
ted below. Your agency writes a significant number of both Home and Renter policies. Therefore, set 

the Agency Commission basis to 12% for new policies and 10% for renewals for one carrier profile to 

be used for Home policies. See Agency Commission Setup. Then, create a duplicate carrier profile 

(see steps below) for XYZ Insurance Company, with the  Agency Commission basis set to 10% for new 

policies and 8% for renewals to be used for renter policies.   Each profile should have a descriptive 

name in the Unique Name field to be easily identified by a user (ie.  XYZHome, and XYZRenter). 

Line of Busi-
ness

New %/Amt Renew %/Amt

Home 12% 10%

Renters 10% 8%

Condo 10% 10%

Duplicating carrier profiles with different commission schedules

To create the duplicate carrier profile with different commission schedules, CMS has provided short-

cuts to use through the Policy Company Setup.

 1.  Create the duplicate profile.  See Policy Company Setup Shortcuts: Using Copy/Paste to 
Duplicate Carrier Information.

 2.  Highlight the duplicate copy, and then click Edit.

 3.  Change the Unique Name field to a descriptive name, identifying the commission structure for 
each profile (e.g. XYZHome).

 4.  Click the Commission tab.

 5.  Click OK to close the message.

 6.  Select a New and Renewal commission Basis and Amount for this carrier profile.

#CopyTo
#CopyTo
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See Agency Commission Setup for the commission basis definitions.

 7.  Verify the information in the other tabs of the duplicate carrier profile (Policy info, Company Info, 

Coverages) and edit accordingly.

 8.  Click OK.

 9.  Click Close to exit Policy/Company Setup.

This duplicate carrier file is now set to calculate the commission using the commission basis indicated. 

When creating a policy, the user must select the correct company in the GPI screen 
based on the commission received for that policy. 

Related Topics
Carrier Download Setup Overview
Importing  Commission Statements
Policy/Company Setup Overview

Agency Commission Setup

HawkSoft CMS  enables you to calculate and track commissions paid to or retained by your agency, 

based on the commission basis  set up for each carrier in CMS.  This article explains how to set up the 

carrier commission basis for your agency.

This task is typically performed by an Owner/Administrator or Manager.

Required Permissions:
In order to complete this task, user permissions must be set to include:

Accounting > Edit Carrier Commission Settings
Setup > Policy/Company Setup

See Setting User Permissions for more information.

#Carrier%20Download%20Setup%20Overview
#Policy/Company%20Setup%20Overview
../../../../../Content/Agency Setup/Manage Agency Users/User Permissions.htm
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Setting up agency commissions

Follow the steps below to add the commission basis for a carrier.  This must be done for 

each carrier (each state) and for each policy type that the carrier pays commission for  

(Auto, Boat, Home, MoPro, Commercial).

 1.  Click the   Settings icon, and then select Policy/Company Setup from the main 

CMS menu bar.

 2.  Select the appropriate carrier profile.

 3.  Click Edit.

 4.  Select the Commission tab in the carrier profile.

 5.  Insert the New and Renewal term Commission Basis using the Basis drop-down 
list.

 l None – No commission is calculated.

 l Agency Bill – Calculates the commission based on the amount in the 
Retained field on an invoice or receipt.  Use this when the agency is retaining 

commission on an invoice or receipt.

If Agency Bill is selected for the New Basis, the Renewal 
field is grayed out but a commission percentage can still 
be entered in the Amount field.

 l Premium Paid – Calculates the commission based on actual premium 
amount paid.

 l Premium Written – Calculates the commission based on the total premium 
amount for new and renewal business, or the pro-rated additional or returned 

premium amount for a cancellation, reinstatement, or endorsement.

 l Flat Fee – Calculates a flat dollar amount for each transaction.

The Flat Fee dollar amount will be calculated for every 
transaction during the New/Renewal term, regardless of 
the type of transaction.

 l Statement Download – The carrier downloads the Direct Bill Commission 
Statement into CMS, and CMS reads the carrier calculations from the 
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downloaded file.

When Statement Download is selected for the New Basis, 
it also applies to Renewal. The Amount fields are unavail-
able, since CMS does not calculate agency commissions 
for carriers that offer downloaded statements.

 l Custom Import – The carrier sends commission statements as a spread-
sheet (CSV, XLSX, or XLS) to be imported with the Commission Importer.  

CMS reads the carrier calculations from the imported file.

When Custom Import is selected for the New Basis, it also 
applies to Renewal. The Amount fields are unavailable, 
since CMS does not calculate agency commissions for 
carriers that offer downloaded statements.

 6.  Enter the commission percentage or flat fee amount in the Percentage 
(%)/Amount field.

 7.  Include Fees: Check this box if CMS should calculate commission on the fees (i.e. 
policy fees).

The commission basis is set up for this carrier. 

 8.  Optional: Enter Agent Commission Exceptions only when the commission paid to 
an agent for this particular company and base policy type is different than the rate 

set in the user’s profile. Setting agent commission exceptions for a user overrides 

the commission set in the user profile. See Agent Commission Setup for more 

information.

Agent commission exceptions

 a.  Click Add.

The Agent Commission dialog opens.

 b.  Select the Agent from the  drop-down list.

 c.  Select the New and Renewal commission basis from the Basis drop-down 
list.
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 l None – No commission is calculated.

 l Commission Paid – Calculates the agent's commission as a per-
centage of the commission amount the carrier pays the agency. 

 l Premium Paid – Calculates the commission based on actual premium 
amount paid. This option is not available when the agency commission 

basis is Premium Written.

 l Premium Written – Calculates the commission based on the total 
premium amount for new and renewal business, or the pro-rated addi-

tional or returned premium amount for a cancellation, reinstatement, or 

endorsement. This option is not available when the agency commission 

basis is Premium Paid.

 l Flat Fee – Calculates a flat dollar amount for each transaction.

The Flat Fee dollar amount will be calculated for 
every transaction during the New/Renewal term, 
regardless of the type of transaction.

 d.  Click OK.

The commission exception has been set and the exception information will appear 

in the Agent Commission Exceptions box.  Repeat steps for other agents as neces-

sary.

 9.  Click Finish to return to the main Policy/Company Setup dialog.

 10.  Select another carrier to set up commissions for, or click Close to exit.

Related Topics
Policy/Company Setup Overview
Setting Up Carriers with Multiple Commission Schedules

Commission and Sales Tracking Users

CMS enables you to create a user profile as a Commissions and Sales Tracking placeholder within 

CMS. Your agency might need placeholder user profiles for commission    and/or sales tracking 

#Policy/Company%20Setup%20Overview
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purposes only. For example, some agencies create a 'House' user to track clients that are assigned to 

the entire agency within commission     and sales reports. 

Users marked as Commission and Sales Tracking Only can be assigned to policies as Agents and 

assigned to clients as Producers/CSRs.    These users  can appear in Commission, Advanced, Agency 

Intelligence, and Sales & Retention reports, but  cannot log into CMS.

This task is typically performed by an Owner/Administrator or Manager.

Required Permissions:
In order to complete this task, user permissions must be set to include:

Setup > User List

See Setting User Permissions for more information.

Create Commission and Sales Tracking profiles

You can designate a new profile  or an existing profile for  tracking purposes.

To create a new profile

 1.  Click the   Settings icon, and then select User List.

The HawkSoft User List dialog opens.

 2.  With any user or template selected, click New, and then click OK.

The profile/template selected in this dialog will not pre-fill information for Com-

missions and Sales Tracking Only users.

 3.  Check the Commissions and Sales Tracking Only box. 
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The User Profile dialog changes to only include the General and Commissions 
tabs.

 4.  Enter user Initials (must be three alphanumeric characters).

Once user initials have been entered and saved, they cannot be 
changed. 

If you make a mistake when inserting user initials, or need to 
change them, you must add a new user, and then delete the old 
profile.

If the old profile is assigned to any policies or clients as an Agent 
or Producer/CSR, you will need to use Search and Replace to 
re-assign the new profile to those clients/policies.

 5.  Enter the user's Name as you would like it to appear on reports.

 6.  Optional: If your agency tracks commission, enter the details of the user's com-

mission.

 a.  Click the Commissions tab.

 b.  Set the user's commission Basis and Percentage/Amount for New busi-
ness.

 c.  Set the user's commission Basis and Percentage/Amount for Renewal 
transactions.

 7.   Click Finish to close the User Profile dialog.

#Search%20and%20Replace
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 8.  Optional: Click Apply to save the User List changes, and then add or edit additional 
user profiles.

 9.  Click OK to close the HawkSoft User List dialog.

To update an existing profile

 1.  Click the   Settings icon, and then select User List.

The HawkSoft User List dialog opens.

 2.  Select a User profile from the list, and then click Edit.

You can't change your own profile to Commissions and Sales 
Tracking only.

 3.  The User Profile for the selected user opens.

 4.  Check the Commissions and Sales Tracking Only box. 

The User Profile dialog changes to only include the General and Commissions 
tabs.

 5.  Optional: Make any additional changes on the General and Commissions tab, as 
needed. 

 6.  Click Finish to close the User Profile dialog.

 7.  Optional: Click Apply to save the User List changes, and then add or edit additional 
user profiles.
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 8.  Click OK to close the HawkSoft User List dialog.

The user profile can be assigned to policies as Agents and assigned to clients as Producers/CSRs.    

This type of profile  can appear in Commission, Advanced, Agency Intelligence, and Sales & Retention 

reports, but  cannot log into CMS. 

Related Topics
Add a New User
Agent Commission Setup
Agent Split Commission Setup
Commission Tracking Overview
User Setup Overview

Agent Split Commission Setup

HawkSoft CMS enables you to set up split commissions between two or three producers on a policy. 

To have CMS calculate split commissions, you must create multiple user profiles. Setting up multiple 

user profiles might also be useful for situations when an agent might earn a commission structure that 

is different from their primary commission structure. 

This article explains how to set up multiple user profiles and how multiple user profiles are used to 

identify when CMS needs to calculate commission splits.

In this topic:

Creating Multiple User Profiles for Split Com-

missions

Split Commission Profile Example

This task is typically performed by an Owner/Administrator or Manager.

Required Permissions:
In order to complete this task, user permissions must be set to include:

Setup > User List

See Setting User Permissions for more information.

../../../../../Content/Agency Setup/Manage Agency Users/Adding a New User.htm
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Creating multiple user profiles for split commissions

 1.  Click the   Settings icon, and then select User List.

 2.  Select the user name that needs the duplicate profile, and then click New.

If no user profile exists, see Add a New User.

 3.  A window opens indicating that the new profile will be based on the selected profile.

 4.  Click OK.

The User Profile dialog opens with the General tab open.

 5.  Enter slightly different user  initials to identify the producer's split commissions (See FR2 and 

RN2 in the example below).  

 6.  Enter the Name of the user.

 7.  Leave the Password field blank.

This is a duplicate user profile and will not be used to log into CMS.

 8.  Optional: Select the User Permissions side-tab, and then click Check All, then click Uncheck 
All permissions.

Because this is a duplicate profile, no user permissions are needed.

 9.  Select the Commissions side-tab.

 10.  Enter the New and Renewal term Commission Basis (typically the same as the original profile) 
and the % / Amount to be used by CMS to calculate the split  commissions. See the example 
below.

 11.  Click Finish to save.

 12.  Optional: Click Apply to save changes and edit a different user's profile.

 13.  Click OK to close the User List dialog.

There are now multiple user profiles for this agent. The user profiles determine what commission struc-

ture to use when calculating the agent's share of the agency commission. 

HawkSoft CMS uses the Agent 1, 2, and 3 fields in the GPI section of a policy to 
determine which producer(s) will receive commission for the policy.  It is important 
to complete the Agent fields  with the correct agent(s) when creating a policy.

../../../../../Content/Agency Setup/Manage Agency Users/Adding a New User.htm
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Split commission profile example                 
In the example below, the two agents produce policies with all of the commission due to them as well 

as commissions split with another agent. Because of the varying commission levels among the agents, 

multiple user profiles must be set up for each agent.  Each profile has its own commission basis set.  

Default User Profile  - Commission is paid to one agent on a policy

Agent: Frank Roosevelt User ID: FDR
Commission %: New/Renewal = 

50%

Agent: Richard Nixon User ID: RMN
Commission %: New/Renewal = 

50%

Split User Profile - Commission is split between two or three agents on a policy

Agent: Frank Roosevelt User ID: FR2
Commission %: New/Renewal = 

25%

Agent: Richard Nixon User ID: RN2
Commission %: New/Renewal = 

25%

When Frank Roosevelt is the only agent receiving the commission on a policy, the Agent 1 field on the 

General Policy Information tab should be set to FDR.  This calculates a commission for Frank to 50% 

on new policies, and 50% on renewal policies.

However, when Frank is splitting commissions with Richard, both Agent 1 and Agent 2 fields on the 

General Policy Information tab must designate the user ID for the split commission basis (Agent 1= 

FR2 and Agent 2= RN2).   This calculates 25% on new and renewal commissions for both Frank and 

Richard on this policy. See General Policy Information for information on Agent 1, 2, and 3 fields.

Related Topics
Agency Commission Setup
             Creating Commission Transactions on a Policy
User Setup Overview
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             Creating Commission Transactions on a Policy
When Commission Tracking in HawkSoft CMS is enabled, CMS begins creating and tracking  com-

mission transactions on all policies. Creating a commission transaction on a policy makes it possible 

for CMS to track and calculate the commission for the agency and the producer. 

You must have the Agents commission basis and amounts set up in the User List and the Agency's 

commission configured in Policy Company Setup for CMS to calculate commissions. See Agent Com-

mission Setup and Agency Commission Setup.

Commission transactions can be created from any policy changes  that  generate a commission, or 

charge-back to the agency and/or agent.  For example, when a policy is issued, endorsed, canceled, 

reinstated, etc.

See Commission Tracking Setup Overview to enable commission tracking and set up commission 

basis for your agency and agents.

This article explains how a commission transaction is automatically created on a policy in CMS, and 

the steps to manually create a commission transaction for any transactions that are not imported into 

CMS.

Required Permissions:
To perform this task, no specific CMS user permissions are required. 

How commission transactions are created

Commission transactions in CMS are created from four possible sources:

See Agency Commission Setup to set up commission basis for each of your carriers.

 l Imported Commission Statements

CMS creates commission transactions automatically when commission statements are imported 

into CMS and the agency reconciles the statements.  

Agency Commission Basis must be set to Statement Download for each 
carrier that downloads, or set to Custom Import for each carrier that sends a 
spreadsheet that can be imported.

See Importing  Commission Statements

 l Retained field on Invoices or Receipts
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CMS creates a commission transaction using the information entered in the Retained field   on an 
Invoice or  Receipt.  The commission transaction is created when a receipt is processed, when a 

Company Payable per Policy invoice is paid to the agency, or when a Company Payable per 

Statement invoice is paid to the carrier by the agency.

See Invoicing Overview  for additional information on the invoice types in CMS.

Agency Commission Basis must be set to Agency Bill .

 l Policy downloads

A downloaded file from a carrier that updates a policy, automatically creates a commission trans-

action.

Agency Commission Basis must be set to Premium Paid or Premium Writ-
ten for each carrier that downloads, or Custom Import for each carrier that 
sends a spreadsheet that can be imported.

 l Manual user input

For carriers that do not send policy downloads or do not provide the commission statements as a 

spreadsheet, users must manually create commission transactions by processing policy declar-

ations received from carriers (via mail, email, etc.).

Agency Commission Basis must be set to Premium Paid or Premium Writ-
ten for each carrier that does not download policy changes or send a spread-
sheet that can be imported.

Manually creating commission transactions on a policy

Follow this procedure to document and manually create commission transactions as you receive 

declaration pages from your  carrier.

This procedure is not necessary if the carrier sends policy downloads, commission 
statement downloads,  spreadsheets that can be imported, or is set to Agency Bill 
commission basis.

 1.  Retrieve the client file, and then select the  policy that correlates with the policy on the declaration 

page.

#Invoicing%20Overview
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 2.  Click Action, and then follow the steps below to update policy information to the appropriate 

Status.

Cancel

To process correspondence regarding cancellation declarations and notices:

 a.  In the Action menu,  select one item in each of the first three lists to describe what promp-

ted this transaction.

 b.  Click Change Policy Status.

 c.  Click Cancelled.

 d.  Select a reason for the cancellation from the Action menu.

The list of Cancellation options can be modified. See Cancellation Sub-Status Setup.

 e.  Verify Date and Time information, edit as needed, and then click OK.

If you selected  NonPay of Premium or Underwriting Reasons, the 
Time field and Cancellation form are not available.  The Add Log 
Entry Comments dialog opens.  Add comments, and then click OK.

The Cancellation Form dialog opens.

 f.  Optional: Create a Cancellation Request/Policy Release (ACORD 35) form. 

If you don't need to create a Cancellation form, uncheck the Print Cancellation Form 

box, and then skip to the last step to complete the log note. 

 i.  Leave the Print Cancellation Form check box selected to  create the form.

Once the form is created, you will have options available in addi-
tion to print, such as  email, attach, and  e-Signature.

 ii.  Optional: Enter a reason for the cancellation in the Cancellation Form Comments 
section, to be included on the form.

 iii.  Click OK.

The Cancellation Request/Policy Release (ACORD 35) form opens.

 iv.  Edit the form as needed, and then click the Print or Send button.

The Print or Send Document dialog opens.

Action Menu.htm
Action Menu.htm
#Cancellation%20Sub-Status%20Setup
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This dialog enables you to  email, print, and attach the form, as well as send the form 

for e-Signature.

Print or Send Document options

The following options can be applied to your document before  you  email, print,  send 

for signature, or attach.

 You can use the Back button at the bottom of the dialog to 
return to your form if additional changes are needed. 
Example: You can perform any action, such as attach the form, 
and then go back and modify the form and attach the modified 
copy as well.

Apply Agent Signature on Action

 CMS enables you to select an electronic signature from the Apply 
Agent Signature on Action drop-down list to add to forms that have 
an Agent or Producer Signature field. 

In addition to your own, signatures for other users 
are available from the drop-down list if permissions 
have been given.
See User Signature Setup for more information.

You must have a signature stored in your CMS profile to use this fea-

ture. See User Signature Setup to add a signature to CMS. 

 CMS enables you to select an electronic signature from the Apply 
Agent Signature on Action drop-down list to add to forms that have 
an Agent or Producer Signature field. 

In addition to your own, signatures for other users 
are available from the drop-down list if permissions 
have been given.
See User Signature Setup for more information.

You must have a signature stored in your CMS profile to use this fea-

ture. See User Signature Setup to add a signature to CMS. 
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Page Range

Select the specific pages to be included with any of the actions selected 

below. For example, if a page of the form has exclusions that don't per-

tain to your state, you can remove that page before sending or printing 

the form.

 Click  to see your signature or to verify that you have 

selected the correct pages.

Attach a copy of the document to the client file on action below

Select this check box before emailing, printing, or sending the doc-

ument for signature, and if you want to attach a copy of the document to 

the client/policy Attachments tab when you are done performing 

actions.

 HawkSoft recommends attaching a copy to the cli-
ent/policy Attachments tab to take advantage of the 
Attachments right-click menu options.

 Click to open the Edit Attachment Properties dialog and 

modify the Description, as well as other attachment details, as needed. 

Available Actions

Select any or all of the actions below, as needed. You can select each action in any 

order. After each action, you will return to the dialog to perform additional options. 

A check mark   appears on each action button when com-
pleted.

Send Email – The Email Recipients dialog opens. Select the recipients 
that you want to send the document to. See Email Recipients for 

detailed instructions.

Client File Right-Click Menus.htm#RightClickActionMenu
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A copy of the email, containing the attached document, is saved to the 

client/policy Attachments list  if the Auto Attach Sent Emails setting in 
General Settings is checked. 

See User Email Setup  to configure CMS to send 
emails through your email provider. 

Print Copy – The Print dialog opens. Select printing options, and then 
click Print. 

Send for E-Signature – The Send Document for E-Signature dialog 
opens. Add signers and email addresses, select  a template or enter a 

message, and drag and drop additional documents to send for sig-

nature as needed. 

See E-Signature  Overview to set up integration 
between CMS and your e-Signature provider.

Attach Copy – The document is saved and attached to the selected cli-
ent/policy Attachments tab. 

If the Attach a copy of the document to the client file on action 
below option was selected before performing any of the above actions, 
a green checkmark indicates that the document has already been 

attached to the client/policy.

 v.  Click Finish and Close when you are done performing Print/Send actions.

The Add Log Entry Comments dialog opens.

 g.  Add comments, as needed, and then click OK.

Issued

To process New Business Declarations or Policy Issued Notices:

 a.  In the Action menu,  select one item  in each of the first three lists to describe what promp-

ted this transaction.

 b.  Click Change Policy Status.

#User%20Email%20Setup
#E-Signature%20Templates
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 c.  Click Issued.

 d.  Select Uprate, Downrate, or As Quoted.

If your agency has Commission Tracking set up in CMS, the Issued 
Rate dialog opens.

Enter or edit the issued rate  in the Rate field as needed, and then click 
OK.

The Edit dialog opens.

 e.   Make any necessary changes to the policy, and then click Finish.

See Change Policy Information for more information.

 f.  Click Finish to close the Action menu.

The Add Log Entry Comments dialog opens.

 g.  Add comments, as needed, and then click OK.

Reinstate

To process Reinstatement Declarations or Notices:

 a.  In the Action menu,  select one item  in each of the first three lists to describe what promp-

ted this transaction.

 b.  Click Change Policy Status.

 c.  Click Reinstate.

The Reinstatement Date dialog opens.

 d.  Enter the Reinstatement Date, and then click OK.

The Add Log Entry Comments dialog opens.

 e.  Add comments as needed, and then click OK.

Renew

To process Renewal Declarations or Notices:

#Change%20Policy%20Information
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 a.  In the Action menu,  select one item  in each of the first three lists to describe what promp-

ted this transaction.

 b.  Click Change Policy Status.

 c.  Click Renew.

The Renewal Date dialog opens.

 d.  Enter the Renewal Date.

If your agency has Commission Tracking set up in CMS , the Renewal 
Date dialog includes a Rate field. Enter or edit the term premium in the 
Rate field, as needed.

 e.   Click OK.

 f.  The Edit dialog opens.

 g.  Make any necessary changes to the policy, and then click Finish.

See Change Policy Information for more information.

 h.  Click Finish to close the Action menu.

The Add Log Entry Comments dialog opens.

 i.  Add comments, as needed, and then click OK.

Endorse

To process Endorsement Declarations or Notices:

 a.  In the Action menu,  select  the method used to communicate the endorsement information. 

For example, Phone, Mail, Download, etc.

 b.  Select From > Company.

 c.  Click Change Client/Policy.

The Edit Client/Policy dialog opens.

 d.  Edit coverages, as needed.

See Processing Endorsements for more information on how to edit coverages.

Action Menu.htm
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 If the endorsement results in a premium change, update the Premium 
amount for any affected coverage.

 e.  Click Finish.

If your agency has Commission Tracking set up in CMS, the Premium 
Change  dialog opens when there is a change in the premium. 

Enter the Date of Change and update Accounting information, as 
needed, and then click OK.

The Change Form dialog opens. 

 f.  Leave the default settings on the Change Form dialog. 

 g.  Click OK.

 h.  Click Finish to close the Action menu.

The Add Log Entry Comments dialog opens.

 i.  Add comments, as needed, and then click OK.  

The policy Status and/or information is updated and a commissionable transaction is cre-

ated.

The commissionable transaction is ready to be reconciled.  See Reconciling a Non-Impor-

ted Commission Statement.

To view a commission transaction on a policy

 1.  Retrieve the client file, and then select the policy that the commission transaction 

was assigned to during the reconciliation.

 2.  Click Action.

The Action menu opens.

 3.  Select Internal > Customer Accounting > Commission Accounting.

The Commission Accounting dialog opens with the Transactions screen open. 

See Reconciling a Non-Imported Commission Statement for instructions on recon-

ciling. 
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Related Topics

Agency Commission Setup
Agent Commission Setup
Correcting a Reconciled Commission Transaction
Creating a Reconcile Report 
Enabling Commission Tracking
Modifying Commission Transactions During Reconciliation
Correcting a Reconciled Commission Transaction

Reconciling Commission Statements Overview
An important step in tracking commissions is reconciling carrier statements and saving the completed, 

corrected transactions to the policies. These reconciled transactions are used to generate agency and 

agent commission reports.  

These articles describe the process for   reconciling imported  and non-imported commission state-

ments. 

Imported Commission Statements

HawkSoft CMS enables your  agency to import   commission  statements for the purpose of reconciling 

and tracking how much the agency was paid and for tracking commissions owed  to the producers. 

Importing  is done automatically as part of the download process if the carrier downloads commission 

statements, or it is done manually through the Commission Importer for statements received as a 

spreadsheet. Once the statements are imported, they must be reconciled to confirm accurate com-

missions paid to the agency and agent.

Imported Commission Statements Overview

Non-Imported Commission Statements

HawkSoft CMS enables you to reconcile  non-imported commission statements received from your car-

riers. Non-Imported commission statements are statements that carriers send to your agency in PDF 

or printed format that cannot be downloaded or imported using the Commission Importer.

Non-Imported Commission Statements Overview

../../../../../Content/Commission Tracking/Setting Up Commission Tracking/Agent Commission Setup.htm
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Reconciling a Commission Transaction Directly from a Policy

This article provides instructions for the unique instance that you might want to reconcile a transaction 

directly from a policy, rather than reconciling from the Reconcile Report. For example, when you 

receive a non-imported commission statement with only one or two transactions, you might save time 

by going  directly to the policies to reconcile. 

Modifying Commission Transactions During Reconciliation

Commission transaction information can be modified during the reconciliation process.  The Reconcile 

Report lists the commission transactions generated as a result of imported commission statements or 

manually created commission transactions on a policy. 

 This article describes the process for editing and creating new commission transactions on a Recon-

cile Report, to make sure that the transactions match those on a commission statement and that the 

correct agent is assigned. 

Modifying Commission Transactions During Reconciliation

If you need to modify or correct a previously reconciled commission transaction or 
statement, see Correcting a Reconciled Commission Transaction.

Overriding Commissions

HawkSoft CMS enables you to override the commission percentages set up in an agent's CMS profile, 

and/or the agency commission set up in Policy/Company Setup. An override can also be applied to the 

term (New/Renewal) for a commission transaction or policy.

This article describes the settings and steps to override a specific commission transaction (Transaction 

Override), and also how to override commissions for a policy (Policy Override).

Overriding Commissions

Reconciling Carrier Fees

Some carriers might include fees on commission statements, such as MVR,    service fees, etc. In order 

to complete the reconciliation of a carrier statement, these fees must be reconciled.

This article describes the method for reconciling  these fees in CMS. 
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 In order to proceed, you must be in the process of reconciling commission transactions in the Recon-

cile Report. 

Reconciling Carrier Fees

Reconciling Flat Fee Commission Transactions

HawkSoft CMS enables you to reconcile flat fee commission transactions and generate a commission 

paid report with a  summary of commissions for agents and/or the agency. 

This article explains the process for creating a reconcile report for flat fee commission transactions, 

and how to reconcile those transactions. 

Reconciling Flat Fee Commission Transactions

Reconciliation Problem Message

This article describes how to respond to the Reconciliation Problem message that appears when CMS 

determines that you have clicked Finish in a Reconcile Report with a transaction that may have 
already been reconciled on a policy.

Reconciliation Problem Message

Imported Commission Statements Overview

HawkSoft CMS enables your  agency to import   commission  statements for the purpose of reconciling 

and tracking how much the agency was paid and for tracking commissions owed  to the producers. 

Importing  is done automatically as part of the download process if the carrier downloads commission 

statements, or it is done manually through the Commission Importer for statements received as a 

spreadsheet. Once the statements are imported, they must be reconciled to confirm accurate com-

missions paid to the agency and agent.  

Importing  Commission Statements

HawkSoft CMS enables your  agency to import   commission  statements for the purpose of reconciling 

and tracking how much the agency was paid and for tracking commissions owed  to the producers. This 

article describes the process for importing  downloaded commission statements as well as   commission 

statements sent by the carrier as a spreadsheet.

Importing  Commission Statements
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Reconciling Imported Commission Statements

The objective of reconciling imported commission statements is to review and confirm that each impor-

ted transaction on the Reconcile Report has been  reconciled, and that the Agent and Agency Com-

mission are correct for all transactions. This article describes the process of reconciling imported 

commission statements.

Reconciling  Imported Commission Statements

If you need to modify or correct a previously reconciled commission transaction or 
statement, see Correcting a Reconciled Commission Transaction.

Troubleshooting Unmatched Imported Commission Transactions

During the process of reconciling  commission statements that have been imported into CMS, trans-

actions that you are unable to reconcile must be reviewed. 

 This article provides troubleshooting steps  to complete the reconciliation for those commission trans-

actions.   To proceed, you must have the commission statement imported and  be in the process of 

reconciling.

Troubleshooting Unmatched Imported Commission Transactions

Reconciling Package Policies

Package policies often have one commission transaction that applies to multiple policies found in the 

HawkSoft CMS client file. CMS automatically reconciles package policies that have the same policy 

number on all lines of business in the package. 

When a commission statement containing a package policy is downloaded, it is matched to the first 

policy  in the package with a matching policy number. If CMS is unable to match a package policy down-

load to a policy number, or the same policy number exists on two client files, the commission is not 

automatically reconciled. 

This article explains how to reconcile an unmatched package policy commission transaction found on a    

commission statement.   To proceed, you must have imported the Commission Statement and be in the 

process of reconciling.

Reconciling Package Policies with One Policy Number



3/5/2026 Copyright © 2015 HawkSoft, Inc., All Rights Reserved. 1890

Importing  Commission Statements

HawkSoft CMS enables your  agency to import   commission  statements for the purpose of reconciling 

and tracking how much the agency was paid and for tracking commissions owed  to the producers. This 

article describes the process for importing  downloaded commission statements as well as   commission 

statements sent by the carrier as a spreadsheet.

Importing  is done automatically as part of the download process if the carrier downloads commission 

statements, or it is done manually through the Commission Importer for statements received as a 

spreadsheet.

CMS enables you to import  commission statements received electronically with a 
CSV, XLSX, or XLS  extension.

To reconcile commission statements that can't be imported into CMS, See Non-
Imported Commission Statements Overview.

See Carrier Downloads Overview for more information on downloading a carrier statement.

In this topic:

Importing Downloaded Com-

mission Statements

Importing CSV and Excel 

Commission Statements

Viewing or Archiving Impor-

ted Commission Statements

This task is typically performed by an Owner/Administrator, Manager, or Bookkeeper.

Required Permissions:
In order to complete this task, user permissions must be set to include:

Accounting > Commission Report

See Setting User Permissions for more information.

Importing downloaded commission statements
Downloaded commission statements are automatically imported into CMS. When a commission state-

ment is included as part of the carrier downloads,  CMS separates the  commission statements from 

policy transactions and holds them  for later processing. When these commission statements are 

#Carrier%20Downloads%20Overview_..114
#Importing_Downloaded_Commission_Statements
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#Importing_CSV_and_Excel_Commission_Statements
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received, a notification appears in your To Do list on the Start Page, and they are also listed on the 
Imported Commission Statements dialog, available for reconciling.

Package Policies in Commission Downloads

When a direct bill commission statement containing a package policy is down-
loaded, it will be matched to only one of the policies in the package,  with a matching 
policy number. 

See Process Carrier Downloads for more information on downloading a carrier statement.

To access the list of  downloaded commission state-

ments

 1.  Click Accounting > Commission Report from the main CMS menu bar.

 2.  Click Import from the HawkSoft Commission Accounting toolbar.

The Imported Commission Statements  dialog opens.

This dialog lists downloaded commission statements and imported commission 

statements that have not been reconciled.

See Reconciling  Imported Commission Statements

Importing  CSV and Excel commission statements

When you receive a commission statement electronically,  as a CSV, XLSX, or XLS spreadsheet, you 

can import the statement into CMS using the Commission Importer.

The Commission Importer  converts the data from the spreadsheet to  a downloaded statement, 

enabling CMS to  reconcile the statement using the same workflow as  a downloaded statement. See  

Reconciling  Imported Commission Statements. The Commission Importer also saves the configuration 

for future statements received from the same carrier.

Prepare the spreadsheet before importing

#Process%20Carrier%20Downloads_..106
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 1.  For best results, review the spreadsheet and make any necessary modifications 

(see Tips below to clean up the data). Make sure the spreadsheet contains CMS 

required data and supported data types.

Tips for  cleaning up the data

 Spreadsheets that contain certain formatting and missing data      can 

cause issues with the Commission Importer. 

Invalid file types – File extensions  not specified in this article, such as  
XLSM or XLSB, are not supported. Open the file and save as a sup-

ported file type (CSV, XLSX, or XLS) before importing.

Merged cells – If the spreadsheet contains merged fields causing 
issues with the import,   try copying the data to your clipboard and use 

the Import from Clipboard option to import the data. See Importing  
Commission Statements below.

Empty cells – Columns with required data (see below) cannot be 
empty. For example, if you have a column that contains the "Trans-
action Types", or "Transaction Dates", all the rows in that column must 

have data.

Invalid Data – The layout of a spreadsheet could inadvertently cause 
invalid data. For example, some  spreadsheets include  a "Total" at the 

bottom of the rows. If the  "Total" label is in a column that contains a 

Date, or a number, this could trigger the Invalid Data error message to 

appear when configuring a carrier.  In these cases, copy the spread-

sheet (including the column headers) and use the Import from Clip-
board option to import the data.

See Common Excel Formulas  to use formulas to modify data in the 

spreadsheet.
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Required data

The Spreadsheet must contain the data described below, for each com-

mission transaction. Make  modifications as needed, prior to importing. 

Carriers do not label the columns with the same terms that CMS uses. 

You will have the opportunity to map the labels during the import pro-

cess. It is important that the spreadsheet contains the actual data listed 

below, to create  commission transactions in CMS.

 l Named Insured – Name of the person or business entity as it's 
displayed on the policy in CMS. This data should be included in 

only one column.

If the First Name and Last Name are in dif-
ferent columns, use an Excel formula to com-
bine the content of the columns into one.

 l Policy Number – The policy number as it's displayed on the 
policy in CMS.

 l Transaction Date – The date the commission transaction is 
effective. 

Valid date formats: 

mm/dd/yyyy

mm-dd-yyyy

 l Transaction Type – The type of transaction (For example: 
Issued, Renewal, Cancellation, Payment).

 l Commissionable Amount –  The premium the commission 
transaction is based on. 

 l Commission Paid – The amount of commission for the trans-
action due to the agency.
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Supported data types

Make sure your spreadsheet  contains only the following  data types. If 

the spreadsheet contains types of data not supported,  modify the 

spreadsheet. 

 l General

 l Date

 l Currency

 l Accounting

 l Percentage – The percentage must be in a whole number (For 

example 14, not .14, to represent 14%).

 2.  Once your spreadsheet is ready, save the spreadsheet if modifications have been 

made. 

Save the modified spreadsheet with a different name, to keep 
the original unmodified spreadsheet.

Optional: You can copy the data to your clipboard, and then use the  Import from 
Clipboard option.

When you copy data to your clipboard, be sure to include the 
header rows as well as the data below the headers. 

Click the   at the top of any screen to access available help.

 Import a spreadsheet
The Commission Importer enables you to import data from a spreadsheet file, 

or from your clipboard when you have copied spreadsheet data tables.

 1.  Click Accounting > Commission Report from the main CMS menu 
bar.
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 2.  Click Import from the HawkSoft Commission Accounting toolbar.

The Imported Commission Statements  dialog opens.

This dialog lists downloaded commission statements and all imported 

commission statements that have not been reconciled. 

 3.  Import your new commission statement.

 l Drag a file from your computer and drop it  in the top section of the 

Imported Commission Statements dialog.

 l Click Import from Clipboard if you copied commission data to 
the clipboard. 

 l Click Browse to  Spreadsheet to browse to a saved commission 
spreadsheet, and then open the file.

The Commission Importer window opens with the Select Data to 
Import tab open.

 4.  If more than one spreadsheet is included in the file, you can select a 

specific Spreadsheet from the available drop-down.

The spreadsheet data appears in the main section of the dialog.

 5.  Select the row that contains column headers (Policy Number, Insured, 

Transaction Type, etc.), and then click Next.

The data listed below the header will be included in 
the import as well as the selected header row. 

The Preview Data to Import dialog opens and displays  your selected 
header row and the data listed in each column.

 6.  Verify that the header row is the top row, and then click  Next.

If the header row and/or data does not look correct, 
click Back to select a different header row.

The Map Imported Data dialog opens.
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This screen enables you to configure how the data is mapped with 

CMS for this carrier's Commission Statement. 

 7.  Enter the Statement Date for the statement you are importing. 

 8.  Configure data for a new carrier if this is the first time you are importing 

this carrier's commission spreadsheet(s), or use the Load  Company  
Configuration button if a spreadsheet for this carrier has been pre-
viously  imported. 

Map imported data (first import)                             

If this is the first time importing a spreadsheet from this  carrier, use the 

Map Imported Data dialog to  configure data for a new carrier. Once 
mapped, you can use the configuration for future imports from the 

same carrier.

 a.   Enter the Company Name for the new configuration.

This is the name your configuration will be saved as. The next 

time you receive a statement from this same carrier, you will want 

to load this configuration to save time.

 b.  Map the required data fields for the information to be included in 

the commission statement.

Field Mapping table

The  Items To Map column includes a list of data 
fields to be mapped so that    a commission statement 

is created  successfully.

Mapping is required for each 
item listed in this column, except 
Commission Rate %.
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Use the drop-downs in the  Mapped Fields column 
to select the field names from the spreadsheet that 

correspond with each of the items to map. 

Items to Map Mapped Fields

Named Insured

Name of the person or busi-

ness entity as it's displayed on 

the policy in CMS.

Policy Number
The policy number as it's dis-

played on the policy in CMS.

Transaction Date
The date the commission 

transaction is effective.

Transaction Type
The type of commission trans-

action. See steps below.

Commissionable 

Amount

The premium the commission 

transaction is based on.  

Commission Rate 

%

The commission percentage 

rate. This field is not required 

to be mapped.  

Commission Paid

The amount of commission for 

the transaction due to the 

agency.

The Transaction Type drop-down opens an addi-
tional mapping dialog. 

 i.  Select Transaction Type from the available 
drop-down options.

#_Transaction_Type_
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The  Items To Map column  lists the trans-
action types found on the  Commission State-

ment. 

 ii.  Use the available drop-down in the Mapped 
Fields column to map these transaction types 
with the appropriate CMS Transaction Types 

(Renewal, Issued, Reinstatement, etc.), and 

then click OK.

Once you have mapped 
the transaction types, you 

can click  on the    to 
modify as needed. 

View of Imported Data table

This  table displays the spreadsheet's column head-

ers in the Field Names column with the cor-
responding data to the right. Use this display to 

review  the data as the fields are being mapped.

Load Company Configuration (previously imported)                             

A statement from this carrier has been previously imported. Once a 

commission statement has been created by the Commission Importer 

for a carrier, you can select the configuration for future downloaded 

commission statements so that you do not have to map the fields again. 

 a.  Click the Load Company Configuration button.

The Company Configurations dialog opens with a list of pre-
viously saved company configurations.

 b.  Select the saved carrier configuration, and then click OK.
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 c.  Review the mapped fields in the Field Mapping table and make 
any necessary changes. 

 9.  Click Next to complete the import process.

If the new spreadsheet contains fields that were not 
mapped for the selected configuration, instructions 
will appear in red text. 

The Create Statement dialog opens. 

 l This dialog lists any rows that will not be included in the imported 

statement  because required fields are missing. Review the items 

listed and re-import the spreadsheet if necessary.

See Importing  Commission Statements to make sure your 

spreadsheet contains the required data.

 l The Commission Statement Total will be  listed at the bottom 
of the statement once the import is complete.

 l CMS calculates the Agency Commission Paid amount based 
on the data mapped for the Commission Paid. This total will also 

be listed at the bottom of the statement once the import is com-

plete. 

This amount can be modified during the reconciliation process.

 10.  Click Finish to complete the import process and   save the configuration 
for this carrier.

The Create Statement confirmation appears. 

 11.  Click OK.

The Imported Commission Statements dialog opens with the new 
commission statement listed and ready to reconcile. 

See Reconciling  Imported Commission Statements.

Viewing or archiving imported commission statements

#Required_fields
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Viewing and/or printing

Once statements have been imported, you can open them to review and/or  print them.

 1.  Click Accounting > Commission Report from the main CMS menu bar.

The HawkSoft Commission Accounting dialog opens.

 2.   Click  Import from the HawkSoft Commission Accounting toolbar.

The Imported Commission Statements dialog opens. Any previously imported 
statements, that have not been reconciled, are listed on this dialog.

 3.  Highlight the commission statement, and then click View.

The selected commission statement opens in the CMS Viewer.

 4.  Optional: Click File > Print to print the commission statement.

 5.  Click File, and then click Exit to close View mode.

Archiving 

 1.  Click Accounting > Commission Report from the main CMS menu bar.

The HawkSoft Commission Accounting window opens.

 2.   Click Import from the HawkSoft Commission Accounting toolbar. 

The Imported Commission Statements dialog opens. Any previously downloaded 
or imported statements, that have not been reconciled, are listed on this dialog.

 3.  Highlight the commission statement, and then click Archive.

A message appears to confirm the archived item. 

 4.  Click Yes.

Viewing reconciled (or archived) commission statements

 1.  Click Accounting > Commission Report from the main CMS menu bar.

The HawkSoft Commission Accounting window opens.

 2.  Click Past.
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The View Past Statements dialog opens.

Both reconciled and archived statements are listed on this dialog.

 3.  Highlight the commission statement, and then click OK.

The selected commission statement opens in  the  CMS Viewer.

 4.  Optional: Click File >Print to print the commission statement.

 5.  Click File, and then click Exit to close View mode.

Related Topics
Carrier Downloads Overview
Reconciling  Imported Commission Statements
Reconciling Commission Statements Overview
Reconciling a Non-Imported Commission Statement

Common Excel Formulas

This article is intended to provide tips for modifying an Excel® spreadsheet before using the CMS Com-

mission Importer. 

You might need to modify a spreadsheet if  the data  is not in the format the Commission Importer 

expects, or the data in the spreadsheet is not  in a format that is compatible with the data in CMS. 

 Example: A carrier might have a "policy number" in the spreadsheet with a prefix that's not included in 

the carrier download. In this case the prefix will not be in CMS. It will need to be removed so that CMS 

can accurately reconcile a commission statement.

See Importing  Commission Statements for additional tips for preparing your spreadsheet before import-

ing. 

To modify data in an Excel spreadsheet

 1.   Insert a new column into your spreadsheet next to the row/column to be modified. 

 2.  Type the formula in the new cell next to the row of data you want to modify. 

#Carrier%20Downloads%20Overview_..114
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 3.  Once the data is re-formatted correctly, use the Excel Drag feature  to copy the for-

mula into each cell in the entire column.

The table below includes a few sample formulas. For additional formulas, please see the 

available Help in Excel.

Current Data Formula Reformatted Data

To combine two columns into one

=CONCATE-
NATE(B2,", " 
A2)

To trim characters from the end

=LEFT(A2, 
LEN(A2)-4)

 The "4" is the 

number of 

characters to 

trim from the 

end.

To trim characters from the begin-

ning
=RIGHT(A2, 
LEN(A2)-1)

The "1" is the 

number of 

characters to 

trim from the 

beginning.
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Current Data Formula Reformatted Data

To convert Date text to Date type

=DATE(LEFT
(C2,4),MID
(C2,5,2),RIG-
HT(C2,2))

 The "4" in the 

LEFT par-

enthesis is the 

number of 

characters 

from the left 

that make up 

the Year. 

The  "5,2" in 

the MID par-

enthesis indic-

ates that the 2 

characters 

beginning on 

the 5th char-

acter is the 

Month. 

The "2" in the 

Right par-

enthesis is the 

Day. 

Modifications 

may need to 

be made to 

this formula, 

depending on 

how the date 
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Current Data Formula Reformatted Data

in text format 

is displayed.

Reconciling  Imported Commission Statements

The objective of reconciling imported commission statements is to review and confirm that each impor-

ted transaction listed on the Reconcile Report matches each policy and  that the Agent and Agency 

Commission are correct for all transactions. 

Once a commission statement has been  imported, it is available for reconciliation. See  Importing  Com-

mission Statements for more information.

This article provides instructions for reconciling an imported commission statement.

In this topic:

Reconcile an Imported State-

ment

View Reconciled Com-

mission Statements

Reconciling  Imported Com-

mission Statements

Required Permissions:
In order to complete this task, user permissions must be set to include:

Accounting > Commission Report

See Setting User Permissions for more information.

To reconcile an  imported statement

 1.  Click Accounting > Commission Report from the main CMS menu bar.

 2.  Click Import from the HawkSoft Commission Accounting toolbar.

The  Imported Commission Statements  dialog opens.

This dialog lists your downloaded and imported commission statements, ready to be reconciled. 

See Importing  Commission Statements for instructions to import a new spreadsheet.

#Reconcile_an_Imported_Statement
#Reconcile_an_Imported_Statement
#View_Reconciled_Commission_Statements
#View_Reconciled_Commission_Statements
../../../../../Content/Agency Setup/Manage Agency Users/User Permissions.htm
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 3.  Select a commission statement from the Imported Commission Statements dialog, and then 
click Next to begin reconciling. 

The Commission Reconciliation Report - Statement Info dialog opens.

 4.  Complete the information on the Commission Reconciliation Report - Statement Info dialog.

 l Reconcile Date  – Enter the date the statement is being reconciled. 

This    date  can be used as a filter when you run  the Agent and/or 
Agency Commission Paid Reports for these transactions.

 l Statement Date – CMS auto-fills this date from the  imported commission statement file. 

This    date  can be used as a filter when you run  the Agent and/or 
Agency Commission Paid Reports for these transactions.

 l Agency Commission Paid – This is an editable field. The amount defaults from the  
imported commission statement file.

 l Agent Commission Paid Date – Enter the date the agents or producers will be paid from 
this statement. 

Use the same Agent Commission Paid Date for future reconciliations. 
For example, if the 20th of the month is chosen, use the 20th of every 
month going forward. This will simplify running commission paid 
reports for previous months.

 5.  Click Finish. 

The Reconcile Report opens, listing each transaction from the downloaded or imported com-
mission statement. 

Reconciled – The R (reconcile)  check boxes indicate whether each transaction has 
been matched with a policy. CMS automatically reconciles each transaction if the 

policy number in the commission statement matches a policy number in CMS. 

Commission Paid – The Commission Paid column contains the commission 
amount due to the agency as listed on the imported statement.

To reconcile matched transactions

#Printing_an_Agent_Commission_Paid_Statement
#Printing_an_Agency_Commission_Paid_Statement
#Printing_an_Agent_Commission_Paid_Statement
#Printing_an_Agency_Commission_Paid_Statement
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The R (reconcile) column has a checkmark on the Reconcile Report for 
each transaction that matches a client/policy in the CMS database. 

Verify the Agent and Agent Commission information.

 l Agent – Verify that the assigned agent in the Agent column(s) is 
consistent with the Agent that is set to receive the commission for 

this policy.  Agent information does not come from the imported 

statement, it comes from the Agent 1, 2, and 3 fields on the policy 

in CMS.

 l Agent Commission – Verify that the Agent Commission column
(s) has the correct commission amount due to the assigned 

agent.

See Modifying Commission Transactions During Reconciliation  if a 

transaction needs to be modified. 

To reconcile unmatched transactions

When the  R (reconcile) column on the Reconcile Report is not checked 
for a transaction, this indicates that CMS has not found a  policy that 

matches the transaction on the carrier commission statement. This 

could be due to discrepancies in the  policy number, an incomplete 

policy, and/or a client file that has not been entered or updated in CMS. 

Follow these steps to manually match these transactions.  

 a.  Check the R (reconcile) box  for the un-reconciled trans-
action.

The Add Accounting Transaction dialog box opens.

 b.  Enter search criteria  for the client  name or policy number, 

and then click Search.
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If the client file is not found, click Insert 
New to add the client as well as the 
policy. 

A comprehensive search should be 
done before creating new cli-
ents/policies to avoid creating duplic-
ates.

 c.  Select the client and click OK.

The Choose a Policy dialog opens with a list of policies 
for that client. 

 d.  Select the appropriate policy, and then click OK.

If the policy is not found, click Insert 
New. Select a policy type from the 
Action menu, and then complete the 
policy information as needed. See  for 
more information.

The transaction is marked as reconciled.

 e.  Repeat these steps for each un-reconciled item to com-

plete the entire statement.

 6.  Once all editing and reconciling is complete, the next step is to finish the report, and then CMS 

will record the transactions  to their respective policies in the database. 

 a.   Verify that the Difference field at the bottom of the report is 0.00.

The Difference field contains the discrepancy between the Agency Commission Paid from 

the commission statement and the sum of the items that have been reconciled.

 b.  Click Finish.

A message appears to indicate that the commissions have been written to the client files.

 c.   Click OK.

Now that the reconciliation is complete, the statement is removed from the Imported Commission State-

ments dialog. the reconciled transactions will be included in the Agency and Agent Commission Paid 

Reports. 

#Printing_an_Agency_Commission_Paid_Statement
#Printing_an_Agent_Commission_Paid_Statement
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To view reconciled commission statements
Once statements have been reconciled, you can view the statements by using the Past icon.

 1.  Click Accounting > Commission Report from the main CMS menu bar.

The HawkSoft Commission Accounting window opens.

 2.  Click Past.

The View Past Statements dialog opens.

Both reconciled and archived statements are listed on this dialog.

 3.  Highlight the commission statement, and then click OK.

The selected commission statement opens in  the  CMS Viewer.

 4.  Optional: Click File > Print to print the commission statement.

 5.  Click File, and then click Exit to close View mode.

To correct a commission statement or transaction
If a reconciled statement or transaction contains an error, you can either correct the individual trans-

action(s) or re-reconcile the commission statement.

For more information, see Correcting a Reconciled Commission Transaction.

Related Topics
Carrier Downloads Overview
Commission Reports
Correcting a Reconciled Commission Transaction
Modifying Commission Transactions During Reconciliation
Commission Paid Statements
Reconciliation Problem Message
Troubleshooting Unmatched Imported Commission Transactions

#Carrier%20Downloads%20Overview_..114
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Troubleshooting Unmatched Imported Commission Transactions

During the process of reconciling  commission statements that have been imported into CMS, trans-

actions that you are unable to reconcile must be reviewed. 

 This article provides troubleshooting steps  to complete the reconciliation for those commission trans-

actions.   To proceed, you must have the commission statement imported and  be in the process of 

reconciling.

See Importing  Commission Statements for more information on the reconciliation process.

In this topic:

Client/Policy is in the CMS but does Not 

Appear when Searching the Reconcile 

Report

The Policy Number in the Client File does Not 

Match the Policy Number in the Commission 

Statement

Duplicate Clients Multiple Policies with the Same Policy Num-

ber

The client/policy is in CMS but it does not appear when 

searching from the Reconcile Report 

Solution:
When a client or policy is not found  when matching transactions from a Recon-

cile Report, yet in CMS you are able to search for and find the client and 

policy, it may be necessary to freshen the indexes.  Follow the steps below to 

freshen indexes:

 1.  Click the   Utilities icon, and then select  File Maintenance.

 2.  Select Freshen Indexes.

 3.  Click Next.

#Client/Policy_is_in_CMS_but_does_not_Appear_when_searching_from_the_Reconcile_Report
#Client/Policy_is_in_CMS_but_does_not_Appear_when_searching_from_the_Reconcile_Report
#Client/Policy_is_in_CMS_but_does_not_Appear_when_searching_from_the_Reconcile_Report
#The_Policy_Number_in_the_Client_File_does_not_Match_the_Policy_Number_in_the_Commission_Statement
#The_Policy_Number_in_the_Client_File_does_not_Match_the_Policy_Number_in_the_Commission_Statement
#The_Policy_Number_in_the_Client_File_does_not_Match_the_Policy_Number_in_the_Commission_Statement
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 4.  Verify that there were no errors displayed when file maintenance is fin-

ished running.

 5.  Re-import the Commission Statement  and begin reconciling again. The 

client and policy in question should be listed, as expected, to match the 

transaction.

See Freshen Indexes [+Video]* for more information.

The policy number in the client file does not match the 

policy number in the commission statement

Solution:
Correct the policy number on the GPI section of the policy in the client file, 

unless the commission statement refers to an old or invalid number, and then 

click the R column in the Reconcile Report to reconcile the commission on the 
policy. It is possible to reconcile the commission to a policy if the policy num-

bers don't match. 

There are duplicate clients

Solution:

 1.  Check each duplicate client file in CMS to determine where the policy 

is, and then check the R column in the Reconcile Report to reconcile 
the  transaction with the correct client file.

 2.  Minimize the report and review the duplicate client files to determine if 

merging them is appropriate.

 See Merging Client Files for more information.

#Freshen%20Indexes%20[+Video]*
#Merging%20Client%20Files
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There are multiple policies with the same policy num-

ber

Solution:

 1.  Minimize the report and review the duplicate policies in CMS.

Package policies can create duplicate policy num-
bers. See Reconciling Package Policies with One 
Policy Number. 

 2.  Determine which policy to keep, and then archive the one(s)  not 

needed. 

 3.  Return to the Reconcile Report, and then repeat the search and match 

the transaction.

Related Topics
Freshen Indexes [+Video]*
Importing  Commission Statements
Merging Client Files

Reconciling Package Policies with One Policy Number

Package policies often have one commission transaction that applies to multiple policies found in the 

HawkSoft CMS client file. CMS automatically reconciles package policies that have the same policy 

number on all lines of business in the package. 

When a commission statement containing a package policy is downloaded, it is matched to the first 

policy  in the package with a matching policy number. If CMS is unable to match a package policy down-

load to a policy number, or the same policy number exists on two client files, the commission is not 

automatically reconciled. 

This article explains how to reconcile an unmatched package policy commission transaction found on a    

commission statement.   To proceed, you must have imported the Commission Statement and be in the 

process of reconciling.

#Freshen%20Indexes%20[+Video]*
#Merging%20Client%20Files
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See Importing  Commission Statementsfor more information.

Required Permissions:

To perform this task, no specific CMS user permissions are required. 

Reconciling a commission transaction for a package policy

As you are reconciling commission transactions in the Reconcile Report, follow the steps 

below when you encounter an unmatched commission transaction for a package policy.

 1.   Check the R (reconcile)   box  for the package policy transaction. 

The Add Accounting Transaction dialog opens. 

 2.  Search for the client, and then click OK. 

If the client file is not found, click Insert New to add the client as 
well as the policy. 

If the client file is not found, click Insert New to add the client as 
well as the policy. 

The Choose a Policy dialog opens.

 3.  Select the first policy from the package with a matching policy number to match with 

the commission transaction.

If the policy is not found, click Insert New. Select a policy type 
from the Action menu, and then complete the policy information 
as needed. See  for more information.

 4.  Click OK.

The Reconcile report now has a checkmark in the R (reconcile) box for this trans-
action, and is reconciled. Repeat the process, matching package policy com-

missions found in the Reconcile Report.

Review the reconciled transaction to ensure the correct Agent, 
and Commission amounts.  Edit the transaction if necessary.  
See Modifying Commission Transactions During Reconciliation 
for more information.
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Related Topics
Correcting a Reconciled Commission Transaction
Creating a Reconcile Report 
Importing  Commission Statements
Modifying Commission Transactions During Reconciliation
Reconciling a Non-Imported Commission Statement
Troubleshooting Unmatched Imported Commission Transactions

Non-Imported Commission Statements Overview

HawkSoft CMS enables you to reconcile  non-imported commission statements received from your car-

riers. Non-Imported commission statements are statements that carriers send to your agency in PDF 

or printed format that cannot be downloaded or imported using the Commission Importer.

To reconcile non-imported commission statements, you must first run a Reconcile Report of com-

mission transactions. CMS creates commission transactions using policy downloads, or from user 

input.   

Creating a Reconcile Report

HawkSoft CMS enables you to create a Reconcile Report to generate a list of commission transactions 

recorded in CMS. This Reconcile Report can be run for a specific carrier  to reconcile the commission 

transactions in the CMS database against a non-imported carrier commission statement.

Creating a Reconcile Report 

Reconciling a Non-Imported Commission Statement

Reconciling a non-imported  commission statement is the process of verifying that commission trans-

actions on a HawkSoft CMS Reconcile Report match the commission transactions on a commission 

statement from the carrier. An agency reconciles the statements to track the amount the agency was 

paid, and to determine the commission amount to pay producers.

Reconciling a Non-Imported Commission Statement

If you need to modify or correct a previously reconciled commission transaction or 
statement, see Correcting a Reconciled Commission Transaction.
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Reconciling a Commission Transaction Directly from a Policy

This article provides instructions for the unique instance that you might want to reconcile a transaction 

directly from a policy, rather than reconciling from the Reconcile Report. For example, when you 

receive a non-imported commission statement with only one or two transactions, you might save time 

by going  directly to the policies to reconcile. 

Reconciling a Commission Transaction Directly from a Policy

Creating a Reconcile Report 

HawkSoft CMS enables you to create a Reconcile Report to generate a list of commission transactions 

recorded in CMS. This Reconcile Report can be run for a specific carrier  to reconcile the commission 

transactions in the CMS database against a non-imported carrier commission statement.

This article explains the steps for running the Reconcile Report.

This task is typically performed by an Owner/Administrator, Manager, or Bookkeeper.

Creating a Reconcile Report is not necessary for reconciling imported commission 
statements. Importing a commission statement automatically creates a Reconcile 
Report for you. See Importing  Commission Statements.

Required Permissions:
In order to complete this task, user permissions must be set to include: 

Accounting > Commission Report

See Setting User Permissions for more information.

Running a Reconcile Report

When creating the Reconcile Report, the goal is to include all transactions listed on the car-

rier commission statement, and then reconcile the transactions with CMS.  This is accom-

plished by using the reporting rules, such as date range and company name.

 1.  Click Accounting > Commission Report from the main CMS menu bar.

The HawkSoft Commission Accounting window opens.

../../../../../Content/Agency Setup/Manage Agency Users/User Permissions.htm
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 2.  Click Reconcile.

The Commission Reconciliation Report - Define Rules dialog opens.

 3.  If this is your first time running a Reconcile Report, click the Back button to choose 
rules for  the report.

Optional: If you have chosen rules for a previous report, you can modify the chosen 

rules. Click Back to access the Choose Rules dialog.

Skip to step 5 if you do not need to modify previously chosen 
rules. 

Select conditions for which accounting transactions will be included in the report. Be 

sure to include the following rules:

 l based on company's commission rules

 l where the Company on the policy is...

 4.  Click Next.

The Commission Reconciliation Report - Define Rules dialog opens. This dia-
log displays the rules for filtering information to be included in the report.

 5.  Define/modify rules for the Reconcile Report as needed:

Click the blue links to select rules.

 l List all accounting transactions is set by default

 l based on the company's commission rules and a transaction date – 
click the click here to specify dates  link or the date range last filtered by.

Select the date range of the transactions listed on the carrier statement and 

then click OK.

 l where the Company on the policy is defaults to the carrier(s) from the last 
time the report was generated.

If this is the first time running a Reconcile Report, rather than displaying the 

carrier(s), you will have a click here to specify link.

Check the carrier(s) whose commission statement(s) you are reconciling on 

the Commission Report Filter dialog, and then click OK.
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Only active carriers appear on the list. To include inactive 
carriers, check the Include Inactive box.

 6.  Click Next.

 7.  Complete the following information on the Commission Reconciliation Report - 
Statement Info dialog:

 l Reconcile Date - Enter the date the statement is being reconciled. 

This   date can be used to run the Agent and/or Agency 
Commission Paid Reports for the transactions in this 
reconcile report.

 l Statement Date - Enter the statement date from the carrier commission state-
ment.

This   date can be used to run the Agent and/or Agency 
Commission Paid Reports for the transactions in this 
reconcile report.

 l Agency Commission Paid - Enter the total amount the company is paying 
the agency as listed on the commission statement. Do not deduct for any fees 

the carrier may be deducting from the total commissions earned.

 l Agent Commission Paid Date - Enter the date the agents or producers will 
be paid from this statement. 

Use the same Agent Commission Paid Date for future 
reconciliations. For example: If the 20th of the month is 
chosen, use the 20th of every month going forward. This 
simplifies running Commission Paid reports.

 8.  Click Finish to run the Reconcile Report. 

The report may take a few minutes while the program searches through every policy 

in your database to find transactions that match the rules you defined.

When the report is finished,  a list of the commission transactions  displays, including 

information such as the name of the customer, policy #, term dates, commission 

#Printing_an_Agent_Commission_Paid_Statement
#Printing_an_Agency_Commission_Paid_Statement
#Printing_an_Agent_Commission_Paid_Statement
#Printing_an_Agency_Commission_Paid_Statement
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paid to the agency, etc.  This list can now be reconciled to the carrier commission 

statement. 

See Reconciling a Non-Imported Commission Statement to begin reconciling.

Related Topics
Commission Tracking Overview
Enabling Commission Tracking
Importing  Commission Statements
Commission Paid Statements
Reconciling a Non-Imported Commission Statement
Working with Reconcile Report Data

Reconciling a Non-Imported Commission Statement

Reconciling a non-imported  commission statement is the process of verifying that commission trans-

actions on a HawkSoft CMS Reconcile Report match the commission transactions on a commission 

statement from the carrier. An agency reconciles the statements to track the amount the agency was 

paid, and to determine the commission amount to pay producers.

During this process, it is common to edit and create commission transactions in CMS to match what is 

on the commission statement from the carrier.  The reconciled commission transactions will be part of 

the Commission Paid Reports.

This article describes the process of reconciling transactions on a Reconcile Report with a carrier com-

mission statement.  To proceed, you must first  run a Reconcile Report in CMS, and have the carrier  

commission statement from the carrier you are reconciling.  See Creating a Reconcile Report  for more 

information.

 Commission Statements are typically reconciled by an Owner/Administrator, Manager, or Book-

keeper.

This procedure only applies to non-imported commission statements. See Import-
ing  Commission Statements to  process imported commission statements. 

../../../../../Content/Commission Tracking/Reconciling Commission Statements/Working with Rec Report DataCSH.htm
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If you need to modify a commission transaction that has already been reconciled, 
seeCorrecting a Reconciled Commission Transaction.

In this topic:

Reconciling Commission 

Transactions

Completing the Recon-

ciliation Process

Save an Unfinished Recon-

cile Report

Required Permissions:
In order to complete this task, user permissions must be set to include:

Accounting > Commission Report

See Setting User Permissions for more information.

Reconciling  commission transactions

 Begin by looking at the carrier statement to see if the commission 
transactions are listed in order by name, date...etc.  You can then sort 
the Reconcile Report in CMS (by clicking on the relevant column head-
ing; name, date...) to try to match the way the items are listed.  This 
makes it easier to find the transactions as you go down the list on your 
carrier statement.

Look at the first commission transaction on the carrier's commission statement and then 

find the same commission transaction on the CMS Reconcile Report.

When the transaction matches 

 l Commission Paid Amount – On the Reconcile Report,  the Com-
mission Paid Amount column is the commission amount paid to the 

agency. The amount in this column should match the amount on the 

statement. 

#Reconciling_Commission_Transactions
#Reconciling_Commission_Transactions
#Completing_the_Reconciliation_Process
#Completing_the_Reconciliation_Process
#Save_an_Unfinished_Reconcile_Report
#Save_an_Unfinished_Reconcile_Report
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 l Agent and Agent Commission – These columns on the Reconcile 
Report indicate the Agent on the policy and the amount of commission 

due to that agent for this transaction. 

When the transaction does not match

 On the Reconcile Report, edit the transaction to match the carrier com-

mission statement.  See  Modifying Commission Transactions During Recon-

ciliation.

When the transaction is not listed on the Reconcile 

Report

On the Reconcile Report,  add a new transaction.  See              Creating Commission 

Transactions on a Policy for more information.

Continue reconciling transactions by comparing the list of commission trans-

actions in the carrier statement to the list in the CMS Reconcile Report. All 

commission transactions that appear on the carrier commission statement 

should be reconciled on the Reconcile Report.

It is possible that some items on the  Reconcile Report will 
be left unchecked. Unchecked items are transactions that 
may appear on the carrier's next commission statement, 
or may be duplicate items.

Completing the reconciliation process
The reconciliation process is complete when you have reconciled all of the transactions on 

the statement from the carrier.  The objective is to reconcile those items that the com-

mission statement indicates were actually paid.



3/5/2026 Copyright © 2015 HawkSoft, Inc., All Rights Reserved. 1920

 1.  Verify that the Difference field at the bottom of the report is 0.00.

The Difference field indicates any discrepancy between the Agency Commission 

Paid amount, entered when creating the Reconcile Report (also found at the top of 

the report), and the sum of the items that have been reconciled. When the Dif-

ference is not 0.00, this is an indication that there might be some commission trans-

actions that are not yet reconciled, or have been reconciled incorrectly.  The Agency 

Commission Paid field at the top of the Reconcile Report might need to be reviewed 

for accuracy.

 2.   Click Finish.

A confirmation message appears.  

 3.  Click OK.

The reconciliation of the carrier's statement is now complete.

To save an unfinished Reconcile Report
 During the process of adding or editing commission transactions, you can save and return 

to  reconcile at a later time. Saving the report saves the list of commission transactions. 

 1.  Click File > Save on the main Reconcile Report menu bar.

Windows Explorer® opens.

 2.  Name your report (for example, Safeco 01312011), and then choose the location 

where you want to save.

 3.  Click Save.

The Reconcile Report is now saved.

 4.  Click File > Exit to close the report.

To Retrieve an unfinished Reconcile Report

When retrieving the report, review the transactions for reconciliation accur-

acy.
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 1.  Click Accounting > Commission Report from the main CMS menu 
bar.

The CMS Commission Accounting window opens.

 2.  Click Open on the main toolbar.

Windows Explorer® opens.

 3.  Browse to the saved file.

 4.  Double-click the file name.

 5.  Re-enter the Reconcile Date, Statement Date, Agency Commission 
Paid Date and Agent Commission Paid Date.

 6.  Continue reconciling your non-downloaded commission statement.

To correct a commission statement or transaction
If a reconciled statement or transaction contains an error, you can either correct the individual trans-

action(s) or re-reconcile the commission statement.

For more information, see Correcting a Reconciled Commission Transaction.

Related Topics
Commission Tracking Overview
Commission Paid Statements
Creating a Reconcile Report 
Correcting a Reconciled Commission Transaction
Modifying Commission Transactions During Reconciliation
Reconciliation Problem Message
Working with Reconcile Report Data

Reconciling a Commission Transaction Directly from a Policy

This article provides instructions for the unique instance that you might want to reconcile a transaction 

directly from a policy, rather than reconciling from the Reconcile Report. For example, when you 
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receive a non-imported commission statement with only one or two transactions, you might save time 

by going  directly to the policies to reconcile. 

For more information about reconciling commission statements from the Reconcile Report, see Recon-

ciling Commission Statements Overview.

If you need to modify a commission transaction that has already been reconciled, 
see Correcting a Reconciled Commission Transaction.

Reconciling  commission transactions on a policy is typically performed by an Owner/ Administrator, 

Manager, or Bookkeeper.

Required Permissions:
In order to complete this task, user permissions must be set to include:

Accounting > Edit Policy Commissions

See Setting User Permissions for more information.

In this topic:

Reconciling a Commission Transaction Dir-

ectly from a Policy

Reconciling a Commission Transaction Dir-

ectly from a Policy

To  reconcile a commission transaction directly from a policy

Reconciling a commission transaction directly from a policy is done on the Edit/Add-Transaction dia-

log. This dialog contains the details of the commission transaction.

 1.  Retrieve the client file, and then select the policy that pertains to the commission transaction.

 2.  Click Action, and then select one item in each of the first three lists to describe what prompted 

this transaction.

 3.  Select Customer Accounting.

 4.  Select Commission Accounting.

The Commission Accounting dialog opens. Transactions that are reconciled are identified by 
a blue R in the Action column.

 5.  Click Add.

../../../../../Content/Agency Setup/Manage Agency Users/User Permissions.htm
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 6.  Complete the Edit/Add - Transaction fields as needed.

 a.  Be sure to enter  the Paid Date.

 b.  Check the Reconciled check box, and then click Yes to confirm that this transaction 
should be reconciled. 

 c.  Enter the Date (reconcile date) and Statement Date.

 d.  Click OK to close the Edit/Add - Transaction dialog.

 7.  Click Finish to close the Commission Accounting dialog.

 8.  Click Finish to close the Action menu.

The Add Log Entry Comments dialog opens.

 9.  Add comments as needed, and then click OK.

To correct a commission statement or transaction
If a reconciled statement or transaction contains an error, you can either correct the individual trans-

action(s) or re-reconcile the commission statement.

For more information, see Correcting a Reconciled Commission Transaction.

Related Topics
Commission Tracking Overview
Creating a Reconcile Report 
Correcting a Reconciled Commission Transaction
Modifying Commission Transactions During Reconciliation
Reconciling Commission Statements Overview

Modifying Commission Transactions During Reconciliation

Commission transaction information can be modified during the reconciliation process.  The Reconcile 

Report lists the commission transactions generated as a result of imported commission statements or 

manually created commission transactions on a policy. 

Edit Add Transaction Dialog.htm
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 This article describes the process for editing and creating new commission transactions on a Recon-

cile Report, to make sure that the transactions match those on a commission statement and that the 

correct agent is assigned. 

Commission Transactions are typically edited/created during the reconciliation process by an Own-

er/Administrator, Manager, or Bookkeeper.

In this topic:

Editing Commission Trans-

actions on a Reconcile 

Report

Adding New Commission 

Transactions to a Reconcile 

Report

Removing Transactions 

from a Reconcile Report

Required Permissions:
In order to complete this task, user permissions must be set to include:

Accounting > Commission Report

See Setting User Permissions for more information.

A commission transaction that has already been reconciled and reported on a com-
mission paid report can be modified from a policy. See Correcting a Reconciled 
Commission Transaction for more information.

Editing  commission transactions on a Reconcile 

Report
Commission transactions can be edited from a Reconcile Report during the reconciliation 

process. See Reconciling  Imported Commission Statements or Reconciling a Non-Impor-

ted Commission Statement. 

 1.  With the Reconcile Report open, double-click on the transaction  to be modified.

The Edit/Add - Transaction dialog opens.

#Editing_Commission_Transactions_on_a_Reconcile_Report
#Editing_Commission_Transactions_on_a_Reconcile_Report
#Editing_Commission_Transactions_on_a_Reconcile_Report
#Adding_New_Commission_Transactions_to_a_Reconcile_Report
#Adding_New_Commission_Transactions_to_a_Reconcile_Report
#Adding_New_Commission_Transactions_to_a_Reconcile_Report
#Removing_Transactions_from_a_Reconcile_Report
#Removing_Transactions_from_a_Reconcile_Report
../../../../../Content/Agency Setup/Manage Agency Users/User Permissions.htm
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Double-clicking on the Commission Paid column only activates 
the Commission Paid field. This will not open the Edit/Add-
Transaction dialog.

 2.  Verify the type of transaction in the Action field and make any necessary changes.

The remaining fields in the Policy Activity section change accord-
ing to the Action on the commission transaction.  The Date, Rate, 
and Premium fields may vary.

 3.  Verify the date of transaction in the Date field and make any necessary changes.

The type of date depends on the selected Action. 

 4.  Verify the amount in the Rate field (Full premium), Payment Amount field (Sched-
uled Payment), or the Net Premium Change field depending on the transaction 
type.

 5.  Don't modify the Entry Date. This date is the date the commission transaction was 
created in CMS.

 6.  Optional: Modify the Agency Commission Info as needed. 

The Agency Commission Info displays the commission due to the agency for each 

transaction, based on the Agency Commission Information entered in the policy.

Override – Select this check box to  override only the term for this specific trans-
action.

Policy Override – Click this button to override the percentage entered in Poli-
cy/Company Setup, if different than what the carrier pays on this specific policy. 

See Overriding Commissions for more information.

 7.  Click the Commission Calculator button in the Agency Commission section to 
have CMS calculate the agency commission amount.  

Or

Manually enter the commission paid listed on your statement in the Commission 
field.
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The Commission field is prefilled for imported transactions. See 
Importing  Commission Statements

 8.  Verify or select the Agent(s)  receiving the commission for this transaction in the 
Agent Commission section.

 9.  Click the Commission Calculator button(s) in the Agent Commission section to 
have CMS calculate the agent commission amount(s).

Or

Manually enter the commission due to the agent(s).

The sum of the three Commission fields in the Agent Com-
mission section should NOT exceed the amount in the Agency 
Commission section.

 10.  Click OK to close the Edit/Add - Transaction dialog.

The commission transaction is now reconciled on the Reconcile Report   and has a 

check mark in the Reconcile (R) box for this transaction.

Adding new commission transactions to a Reconcile 

Report
When a commission transaction is included in a commission statement but does not exist 

in CMS, you  can add the transaction in CMS during the reconciliation process.   To pro-

ceed, you must have the Reconcile Report in CMS created. See Creating a Reconcile 

Report  for more information.

Do not create new commission transactions when importing and recon-
ciling imported Commission Statements.

 1.  With the Reconcile Report open, click the New icon on the Reconcile Report tool-
bar.

The Add Accounting Transaction dialog opens.

 2.  Search for the client by name or policy number, and then click Search.
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 3.  Select the client, and then click OK.  

 If the client file is not found, click Insert New to add the client as 
well as the policy. 

A comprehensive search should be done before creating new cli-
ents/policies to avoid creating duplicates.

The Choose a Policy dialog opens.

 4.  Select the appropriate policy, and then click OK
.

If the policy is not found, click Insert New. Select a policy type 
from the Action menu, and then complete the policy information 
as needed. See  for more information.

The Edit/Add - Transaction dialog opens.

 5.  Select the type of transaction from the Action drop-down list.

The remaining fields on the Policy Activity section change 
according to the Action selected. The Date, Rate, and Premium 
fields may vary.

 6.  Complete the  amount in the Rate field (Full premium), Payment Amount field 
(Scheduled Payment), or the Net Premium Change field depending on the trans-
action type. 

The Rate, Net Premium Change field, and all Commission fields 
are calculator fields. You are able to use the math keys on your 
keyboard for basic computations.

 7.  Enter the Entry Date.  

This is the date the commission transaction is created in CMS.

 8.  Optional: Modify the Agency Commission Info as needed. 
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The Agency Commission Info displays the commission due to the agency for each 

transaction, based on the Agency Commission Information entered for the policy.

Override – Select this check box to  override only the term for this specific trans-
action.

Policy Override – Click this button to override the percentage entered in Poli-
cy/Company Setup, if different than what the carrier pays on this specific policy. 

See Overriding Commissions for more information.

 9.  Click the Commission Calculator button in the Agency Commission section to have 
CMS calculate the agency commission amount.

OR

Manually enter the commission paid from your statement in the Commission field.

 10.  Verify or select the Agent(s)  receiving the commission for this transaction in the 
Agent Commission section.

 11.  Click the Commission Calculator button(s) in the Agent Commission section to 
have CMS calculate the agent commission amount(s).  

OR

 Manually enter the commission due to the agent(s).

The sum of all Commission fields in the Agent Commission sec-
tion should NOT exceed the amount in the Agency Commission 
section.

 12.  Click OK to close the Edit/Add - Transaction dialog.

The Commission Transaction is now created and reconciled on the Reconcile Report and 

has a check mark in the Reconcile (R) box for this transaction.

Removing transactions from a Reconcile Report
You can remove a transaction directly from the Reconcile Report if needed. The trans-

action will also be removed from the client file.   To proceed, you must have the Reconcile 

Report in CMS created. See Creating a Reconcile Report  for more information.
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 1.  With the Reconcile Report open, right-click on the transaction to be removed, and 

then select Delete from the menu. 

A confirmation message appears, with a warning that the transaction will also be 

removed from the client's file.

 2.  Click Yes to confirm.

Related Topics
Commission Tracking Setup Overview
Creating a Reconcile Report 
Importing  Commission Statements
Overriding Commissions
Reconciling  Imported Commission Statements
Reconciling a Non-Imported Commission Statement
The Edit/Add Transaction Dialog
Troubleshooting Unmatched Imported Commission Transactions

Commission transaction information can be modified during the reconciliation process.  The Reconcile 

Report lists the commission transactions generated as a result of imported commission statements or 

manually created commission transactions on a policy. 

 This article describes the process for editing and creating new commission transactions on a Recon-

cile Report, to make sure that the transactions match those on a commission statement and that the 

correct agent is assigned. 

Commission Transactions are typically edited/created during the reconciliation process by an Own-

er/Administrator, Manager, or Bookkeeper.

Required Permissions

To complete this task, user permissions must be set to include:

 Accounting:

   Commission Report

See Setting User Permissions for more information.

../../../../../Content/Commission Tracking/Creating Commission Transactions/Edit Add Transaction Dialog.htm
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 A commission transaction that has already been reconciled and reported on a com-
mission paid report can be modified from a policy. See Correcting a Reconciled 
Commission Transaction for more information.

Editing  commission transactions on a Reconcile 

Report
Commission transactions can be edited from a Reconcile Report during the reconciliation 

process. See Reconciling  Imported Commission Statements or Reconciling a Non-Impor-

ted Commission Statement. 

 1.  With the Reconcile Report open, double-click on the transaction  to be modified.

The Edit/Add - Transaction dialog opens.

Double-clicking on the Commission Paid column only activates 
the Commission Paid field. This will not open the Edit/Add-
Transaction dialog.

 2.  Verify the type of transaction in the Action field and make any necessary changes.

The remaining fields in the Policy Activity section change accord-
ing to the Action on the commission transaction.  The Date, Rate, 
and Premium fields may vary.

 3.  Verify the date of transaction in the Date field and make any necessary changes.

The type of date depends on the selected Action. 

 4.  Verify the amount in the Rate field (Full premium), Payment Amount field (Sched-
uled Payment), or the Net Premium Change field depending on the transaction 
type.

 5.  Don't modify the Entry Date. This date is the date the commission transaction was 
created in CMS.

 6.  Optional: Modify the Agency Commission Info as needed. 

The Agency Commission Info displays the commission due to the agency for each 

transaction, based on the Agency Commission Information entered in the policy.
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Override – Select this check box to  override only the term for this specific trans-
action.

Policy Override – Click this button to override the percentage entered in Poli-
cy/Company Setup, if different than what the carrier pays on this specific policy. 

See Overriding Commissions for more information.

 7.  Click the Commission Calculator button in the Agency Commission section to 
have CMS calculate the agency commission amount.  

Or

Manually enter the commission paid listed on your statement in the Commission 
field.

The Commission field is prefilled for imported transactions. See 
Importing  Commission Statements

 8.  Verify or select the Agent(s)  receiving the commission for this transaction in the 
Agent Commission section.

 9.  Click the Commission Calculator button(s) in the Agent Commission section to 
have CMS calculate the agent commission amount(s).

Or

Manually enter the commission due to the agent(s).

The sum of the three Commission fields in the Agent Com-
mission section should NOT exceed the amount in the Agency 
Commission section.

 10.  Click OK to close the Edit/Add - Transaction dialog.

The commission transaction is now reconciled on the Reconcile Report   and has a 

check mark in the Reconcile (R) box for this transaction.

Adding new commission transactions to a Reconcile 

Report
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When a commission transaction is included in a commission statement but does not exist 

in CMS, you  can add the transaction in CMS during the reconciliation process.   To pro-

ceed, you must have the Reconcile Report in CMS created. See Creating a Reconcile 

Report  for more information.

Do not create new commission transactions when importing and recon-
ciling imported Commission Statements.

 1.  With the Reconcile Report open, click the New icon on the Reconcile Report tool-
bar.

The Add Accounting Transaction dialog opens.

 2.  Search for the client by name or policy number, and then click Search.

 3.  Select the client, and then click OK.  

If the client file is not found, click Insert New to add the client as 
well as the policy. 

A comprehensive search should be done before creating new cli-
ents/policies to avoid creating duplicates.

The Choose a Policy dialog opens.

 4.  Select the appropriate policy, and then click OK.

If the policy is not found, click Insert New. Select a policy type 
from the Action menu, and then complete the policy information 
as needed. See  for more information.

The Edit/Add - Transaction dialog opens.

 5.  Select the type of transaction from the Action drop-down list.

The remaining fields on the Policy Activity section change 
according to the Action selected. The Date, Rate, and Premium 
fields may vary.
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 6.  Complete the  amount in the Rate field (Full premium), Payment Amount field 
(Scheduled Payment), or the Net Premium Change field depending on the trans-
action type. 

The Rate, Net Premium Change field, and all Commission fields 
are calculator fields. You are able to use the math keys on your 
keyboard for basic computations.

 7.  Enter the Entry Date.  

This is the date the commission transaction is created in CMS.

 8.  Optional: Modify the Agency Commission Info as needed. 

The Agency Commission Info displays the commission due to the agency for each 

transaction, based on the Agency Commission Information entered for the policy.

Override – Select this check box to  override only the term for this specific trans-
action.

Policy Override – Click this button to override the percentage entered in Poli-
cy/Company Setup, if different than what the carrier pays on this specific policy. 

See Overriding Commissions for more information.

 9.  Click the Commission Calculator button in the Agency Commission section to have 
CMS calculate the agency commission amount.

OR

Manually enter the commission paid from your statement in the Commission field.

 10.  Verify or select the Agent(s)  receiving the commission for this transaction in the 
Agent Commission section.

 11.  Click the Commission Calculator button(s) in the Agent Commission section to 
have CMS calculate the agent commission amount(s).  

OR

 Manually enter the commission due to the agent(s).
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The sum of all Commission fields in the Agent Commission sec-
tion should NOT exceed the amount in the Agency Commission 
section.

 12.  Click OK to close the Edit/Add - Transaction dialog.

The Commission Transaction is now created and reconciled on the Reconcile Report and 

has a check mark in the Reconcile (R) box for this transaction.

Removing transactions from a Reconcile Report
You can remove a transaction directly from the Reconcile Report if needed. The trans-

action will also be removed from the client file.   To proceed, you must have the Reconcile 

Report in CMS created. See Creating a Reconcile Report  for more information.

 1.  With the Reconcile Report open, right-click on the transaction to be removed, and 

then select Delete from the menu. 

A confirmation message appears, with a warning that the transaction will also be 

removed from the client's file.

 2.  Click Yes to confirm.

Related Topics
Commission Tracking Setup Overview
Creating a Reconcile Report 
Importing  Commission Statements
Overriding Commissions
Reconciling  Imported Commission Statements
Reconciling a Non-Imported Commission Statement
The Edit/Add Transaction Dialog
Troubleshooting Unmatched Imported Commission Transactions

Overriding Commissions

HawkSoft CMS enables you to override the commission percentages entered in an agent's 

CMS profile, and/or the agency commission configured in Policy/Company Setup. An override can also 

be applied to the term (New/Renewal) for a commission transaction or policy.

../../../../../Content/Commission Tracking/Creating Commission Transactions/Edit Add Transaction Dialog.htm
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 The override is typically set when reconciling a carrier commission statement. A commission override 

can apply one time to a specific commission transaction, or it can apply at the policy level for all future 

commission transactions for that policy. 

This article describes the settings and steps to override a specific commission transaction (Transaction 

Override), and also how to override commissions for a policy (Policy Override).

This procedure is performed by an Owner/Administrator, Manager, or Bookkeeper.

In this topic:

Override a Single Commission Transaction Overriding the Commission Term for a 

Policy

Required Permissions:
In order to complete this task, user permissions must be set to include:

Accounting > Edit Policy Commission > Commission Report

See Setting User Permissions for more information.

Overriding a single commission transaction
A commission transaction override will change only the selected  commission transaction.  

This may be necessary when a correction to the term needs to be made.  Follow the steps 

below to override the calculated term, with a different term and its corresponding com-

mission percentage.

Commission overrides for the term or agency commissions should not 
be performed on an imported commission statement. However, you 
can override commissions for an agent on imported commission state-
ments.

 1.  With the Reconcile Report open, double-click on the transaction  to be modified. 

The Edit/Add Transaction dialog opens.           

 2.  Click the Override check box in the Agency Commission Info section. 

#To__override_a_single_commission_transaction
#Overriding_the_Commission_Term_for_a_Policy
#Overriding_the_Commission_Term_for_a_Policy
../../../../../Content/Agency Setup/Manage Agency Users/User Permissions.htm
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Transaction Override appears below the Term field when checked.

This will activate the Term drop-down list.

 Commission transactions that were created with the Agency Bill 
commission basis are considered overrides and will already 
have the Override box checked.

 3.  Select the appropriate Term from the drop-down list.

The percentage of the corresponding commission for the selected Term displays  in 

the Commission Basis field. The commission basis is configured in Poli-
cy/Company Setup.

 4.   Click the Commission Calculator icon to recalculate the commission for the 
Agency and/or Agent(s).

The Calculator icon is disabled when the commission trans-
action is a Retained (Agency Bill) commission.  Changing the 
commission amount here may affect retained commission bal-
ances in QuickBooks® when the agency integrates with Quick-
Books.

 5.  Click OK.

The Edit/Add - Transaction dialog closes.

The Commission Transaction is now reconciled on the Reconcile Report and has a check 

mark in the Reconcile (R) box for this transaction. CMS will now use the selected term 
and corresponding commission percentage for this commission transaction only.

Overriding the commission term for a policy
HawkSoft enables you to set a temporary policy override for the commission percentages 

for a new or renewal term for a specific date range, or you can set a policy override for all 

future commission transactions for the life of the policy. 

Examples of when you might override the commission:

 l Commission Term Override – You might want to set commission for the first 12 
months of a Life Insurance policy, and then set the policy to automatically switch to 

PCSUCommissions.htm
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no commission at the end of the 12 month period.

 l Commission Override (life of policy) – A carrier is set to 15% commission for 

new business and 10% for renewals  in Policy/Company Setup. This is the most com-

mon commission percentage for this carrier. During the reconciliation process, a 

policy on the carrier statement has a different percentage than what is being cal-

culated from the CMS Policy/Company Setup. You can set the override for the life of 

the policy to match the carrier's commission. 

If you have a carrier with multiple commission schedules, you can configure multiple 

profiles for the carrier in HawkSoft. See Setting Up Carriers with Multiple Com-

mission Schedules.

 These examples apply to non-imported commission statements 
only. 

Commission Overrides for the agency are not recommended for 
imported statements, however, you can override commissions 
for an agent.

Contact the carrier for corrections to imported commission state-
ments.

 1.  With the Reconcile Report open, double-click on the transaction to be modified.

The Edit/Add Transaction dialog opens.

 2.  Click the Policy Override button.

The Edit - Policy Overrides dialog opens.

Commission Term Override (specified date range)

 1.   Check the Commission Term Override box to set an override on the policy term.  

 2.  Select the term from the Start drop-down, and then enter the start date for the over-
ride and the number of months for the duration of the override.

 3.  Determine whether the  policy commission should be set to Renewal or No Com-
mission after the override is complete.

 4.  Click OK.

The Edit - Policy Overrides dialog closes.

Edit Add Transaction Dialog.htm
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 5.  Review the information on the Edit/Add Transaction dialog, and click the Com-
mission Calculator icon to recalculate the new commission for the agency and/or 
agent(s).

The Calculator icon is disabled when the commission trans-
action is a Retained (Agency Bill) commission.  Changing the 
commission amount here may affect retained commission bal-
ances in QuickBooks, when the agency integrates with Quick-
Books.

 6.  Click OK.

The Edit/Add Transaction dialog closes.

The Commission Transaction is now reconciled on the Reconcile Report and has a check 

mark in the Reconcile (R) box for this transaction. CMS will now use the indicated per-

centage for this policy for all future calculations.

Commission Override (life of policy)

 1.   Check the Override Agency Commission box and/or the Override [Agent] Com-
mission box, and then enter the commission percentage(s).

To override commissions for agents in this dialog, all relevant 
agents must be listed on the policy GPI screen (Agent 1, 2 or 3)  
in the CMS client file. However, you are able to add them, and 
manually add the commissions. See Modifying Commission 
Transactions During Reconciliation.

 2.  Click OK.

The Edit - Policy Overrides dialog closes.

 3.  Review the information on the Edit/Add Transaction  dialog, and click the Com-
mission Calculator icon to recalculate the new commission for the agency and/or 
agent(s).

The Calculator icon is disabled when the commission trans-
action is a Retained (Agency Bill) commission.  Changing the 
commission amount here may affect retained commission bal-
ances in QuickBooks, when the agency integrates with Quick-
Books.

Edit Add Transaction Dialog.htm
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 4.  Click OK.

The Edit/Add Transaction dialog closes.

The Commission Transaction is now reconciled on the Reconcile Report and has a check 

mark in the Reconcile (R) box for this transaction. CMS will now use the indicated per-

centage for this policy for all future calculations.

Related Topics
Agency Commission Setup
Agent Commission Setup
Creating a Reconcile Report 
Modifying Commission Transactions During Reconciliation
Reconciling a Non-Imported Commission Statement
Setting Up Carriers with Multiple Commission Schedules
The Edit/Add Transaction Dialog

Reconciling Carrier Fees

Some carriers might include fees on commission statements, such as MVR,    service fees, etc. In order 

to complete the reconciliation of a carrier statement, these fees must be reconciled.

This article describes the method for reconciling  these fees in CMS. 

 In order to proceed, you must be in the process of reconciling commission transactions in the Recon-

cile Report. 

See Reconciling  Imported Commission Statements or Reconciling a Non-Imported Commission State-

ment for more information.

 This is typically done by the Agency Owner, Administrators, Managers, or Agency Bookkeeper. 

Required Permissions:

To perform this task, no specific CMS user permissions are required. 

../../../../../Content/Commission Tracking/Setting Up Commission Tracking/Agent Commission Setup.htm
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Reconciling transactions with carrier fees

To reconcile carrier fees, they must be assigned to a "policy" in a Carrier Client file. 

Example: To reconcile fees for a commission statement from XYZ Company, create a Car-
rier Client file for XYZ Company in CMS. By default, a policy type of "Other" is added to the 

Carrier Client file.  Reconcile the fee commission transactions  to the policy, as well as all 

fee commission transactions going forward. 

HawkSoft Inc. recommends inserting your Carrier Client files before 
reconciling carrier fees, following the steps in Inserting a New Carrier 
Client File. 

You can use a shortcut, described below, to quickly add a Carrier Cli-
ent file with a policy during the reconciliation process. The shortcut 
does not include all of the steps for properly completing a Carrier Client 
file.  It is important to remember to finish proper set up of the files when 
you are done reconciling.

Commission transaction for a fee is found on Recon-

cile Report (imported statement)  

When a fee is found on the Reconcile Report, match the transaction to the 

policy on the Carrier Client file in CMS.

 1.  Check the R (reconcile) box for the un-reconciled transaction.

The Add Accounting Transaction dialog opens.

 2.  Enter search criteria  for the carrier name, and then click Search.

If the Carrier file is not found, click Insert New to 
add the Carrier Client as well as the policy. See 
Inserting a New Carrier Client File for additional 
steps to properly add a new Carrier Client file.

 A comprehensive search should be done before 
creating new files to avoid creating duplicates.

 3.  Select the carrier, and then click OK.

The Choose a Policy dialog opens with a list of policies for that client. 

#Inserting%20a%20New%20Carrier%20Client%20File
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 4.  Select the  policy from the Choose Policy dialog, and then click OK.

If the policy is not found, click Insert New. Select a 
policy type from the Action menu, and then com-
plete the policy information as needed. See  for 
more information.

 5.  Double-click the transaction to open the Edit/Add - Transaction dia-
log.

 6.  Select Adjustment from the Action drop-down list.

 7.  Enter the Date of the commission statement in the Date of Change 
field.

 8.  Enter the fee amount in the Agency Commission field.

To enter a negative amount in a field, type: "0 - 
amount", and then click Tab.

 9.  Click OK. 

The transaction is marked as reconciled.

Commission transaction for a fee is not found on 

Reconcile Report (non-imported statement)

When a fee appears on a carrier statement, but is not found on the Reconcile 

Report in CMS, create a new commission transaction for the fee. 

 1.  Click New on the toolbar at the top of the report.

 2.  Enter search criteria  for the carrier name, and then click Search.

If the Carrier file is not found, click Insert New to 
add the Carrier Client as well as the policy. See 
Inserting a New Carrier Client File for additional 
steps to properly add a new Carrier Client file.

#Inserting%20a%20New%20Carrier%20Client%20File
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A comprehensive search should be done before cre-
ating new files to avoid creating duplicates.

 3.  Select the carrier from the search results, and then click OK.

The Choose a Policy dialog opens with a list of policies for that client. 

 4.  Select the  policy from the Choose Policy dialog, and then click OK.

If the policy is not found, click Insert New. Select a 
policy type from the Action menu, and then com-
plete the policy information as needed. See  for 
more information.

 5.  Double-click the transaction to open the Edit/Add - Transaction dia-
log.

 6.  Select Adjustment from the Action drop-down list on the Edit/Add - 
Transaction.

 7.  Enter the Date of the commission statement in the Date of Change 
field.

 8.  Enter the fee amount in the Agency Commission field.

To enter a negative amount in a field, type: "0 - 
amount", and then click Tab.

 9.   

 10.  Click OK. 

See Modifying Commission Transactions During Reconciliation for more 

information.

The transaction is now reconciled successfully, enabling you to continue with 

the reconciliation process. 

Related Topics
Creating a Reconcile Report 
Importing  Commission Statements
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Modifying Commission Transactions During Reconciliation
Reconciling a Non-Imported Commission Statement

Reconciling Flat Fee Commission Transactions

HawkSoft CMS enables you to reconcile flat fee commission transactions and generate a commission 

paid report with a  summary of commissions for agents and/or the agency. 

This article explains the process for creating a reconcile report for flat fee commission transactions, 

and how to reconcile those transactions. 

 In order for a flat fee commission transaction to be created, the agency commissions must be set to a 

Flat Fee basis. See Agency Commission Setup for more information about setting up the commission 

basis for your agency. 

This procedure is typically completed by an Owner/Administrator, Manager, or Bookkeeper.

In this topic:

Creating the Flat Fee Reconcile Report Reconciling Fees

Required Permissions:
In order to complete this task, user permissions must be set to include:

Accounting > Commission Report

See Setting User Permissions for more information.

Creating the Flat Fee  Reconcile Report
The flat fee  commission basis calculates a commission for every commissionable trans-

action. For this reason, you must specify the transaction type and date range while cre-

ating the Reconciliation Report as described in the steps below.

 1.  Click Accounting > Commission Report from the main CMS menu bar.

The HawkSoft Commission Accounting window opens.

 2.  Click Reconcile.

#Creating_the_Flat_Fee_Reconcile_Report
#Reconciling_Fees
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The Commission Reconciliation Report - Define Rules dialog opens.

 3.  If this is your first time running a Flat Fee Reconcile Report, click the Back button to 
Choose Rules for the Report.

Optional: If you have chosen rules for a previous report, you can modify the Chosen 

Rules. Click Back to access the Choose Rules dialog.

Skip to step 5 if you do not need to modify previously chosen 
rules.

To choose rules, select conditions for which accounting transactions will be included 

in the report. Be sure to include the following rules:

 l Where the Company on the policy is...

 l Which have a transaction type of...

 l Which have a transaction date of...

 4.  Click Next.

The Commission Reconciliation Report - Define Rules dialog opens. This dia-
log displays the rules for filtering information to be included in the report.

 5.  Define/modify rules for the report as needed.

Click the blue links to select rules.

 l List all accounting transactions is set by default. You don't need to modify 
this rule.

 l where the Company on the policy is defaults to the carrier(s) from the last 
time the report was generated.

Check the carrier(s) whose commission statement(s) you are reconciling on 

the Commission Report Filter dialog, and then click OK.

 l with a transaction type of

Click the click here to specify link  to select the transaction type from the  
Commission Report Filter dialog.

Check the transaction type(s) you are reconciling, and then click OK.
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If you are paying an agent a Flat Fee on New Business 
only, select New.

 l which have a transaction date of

Click the click here to specify dates link to select the date range of the trans-
actions from the Enter Entry Date dialog.

Click OK.

 6.  Click Next.

 7.  Complete the following information on the Commission Reconciliation Report - 
Statement Info dialog:

 l Reconcile Date - Enter the date the statement is being reconciled. 

This   date can be used to run the Agent and/or Agency 
Commission Paid Reports for the transactions in this 
reconcile report.

 l Statement Date - Enter the statement date from the carrier commission state-
ment.

This   date can be used to run the Agent and/or Agency 
Commission Paid Reports for the transactions in this 
reconcile report.

 l Agency Commission Paid - Enter the total amount the company is paying 
the agency as listed on the commission statement. Do not deduct for any fees 

the carrier may be deducting from the total commissions earned.

 l Agent Commission Paid Date - Enter the date the agents or producers will 
be paid from this statement. 

Use the same Agent Commission Paid Date for future 
reconciliations. For example: If the 20th of the month is 
chosen, use the 20th of every month going forward. This 
simplifies running Commission Paid reports.

 8.  Click Finish to run the Reconcile Report.

#Printing_an_Agent_Commission_Paid_Statement
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The report may take a few minutes while the program searches through every policy in 

your database to find transactions that match the defined rules.

When the report is finished,  a list of the commission transactions found, displays inform-

ation about that commission transaction such as name of the customer, policy #, term 

dates, commission paid to the agency, etc. This list can now be reconciled to the carrier 

commission statement.

Reconciling fees
Review the transactions on the carrier statement and follow the steps below to reconcile.

 1.  Double-click on the transaction to reconcile on the Reconcile Report.

The Edit/Add - Transaction dialog box opens. See The Edit/Add Transaction Dia-
log and              Creating Commission Transactions on a Policy for additional information 

about this dialog.

Double-clicking on the Commission Paid column only activates 
the Commission Paid field, it does not open the Edit/Add-Trans-
action dialog.

 2.  Click the Commission Calculator button in the Agency Commission section to 
have CMS add the flat fee from the Policy Company Setup to this commission trans-

action. 

 3.  Click on the Commission Calculator button in the Agent Commission section to 
have CMS calculate the agent commission.

 4.  Click OK.

The Commission transaction  is now reconciled and has a checkmark in the Recon-
cile (R) box for this transaction.

 5.  Repeat for all commissionable transactions  on the carrier commission statement.

 6.  When all commissionable transactions have been reconciled, click Finish.

A message appears to indicate that the transactions have been written to the client files. 

The reconciliation of this carrier's statement is now complete. For a printable summary of 

the flat fee commissions, see Commission Paid Statements. 
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Related Topics

Agency Commission Setup
Enabling Commission Tracking
Modifying Commission Transactions During Reconciliation
Commission Paid Statements

Reconciliation Problem Message

This article describes how to respond to the Reconciliation Problem message that appears when CMS 

determines that you have clicked Finish in a Reconcile Report with a transaction that may have 
already been reconciled on a policy.

This task is typically performed by an Owner/Administrator, Manager, or Bookkeeper.

In this topic:

Duplicate Reconciled Trans-

action

Commission Transactions Reconciliation Problem Mes-

sage Options

Required Permissions:
In order to complete this task, user permissions must be set to include:

Accounting > Edit Policy Commissions

See Setting User Permissions for more information.

Duplicate reconciled transaction
CMS determines the transaction is a duplicate if  the following fields in the commission 

transaction are identical in the client file and on the Reconcile Report.

 l Transaction Effective Date

 l  Transaction Type

 l  Statement Date

#Duplicate_Reconciled_Transaction
#Duplicate_Reconciled_Transaction
#Commission_Transactions
#Reconciliation_Problem_Message_Options
#Reconciliation_Problem_Message_Options
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When encountering the Reconciliation Problem message, follow the steps below to review 

the commission transactions before making the appropriate selection.

See Reconciliation Message and Options below for a description of the options in the 

Reconciliation Problem Message.

Commission transactions 

 1.  Select Return to report and highlight these entries from the error message 
options, and then click OK. 

This highlights the duplicate transactions on the Reconcile Report.

 2.  Review the highlighted commission transactions and verify if they have been pre-

viously reconciled. This is done by comparing previous commission statements 

from the carrier with the reconciled commission transactions on the policy in ques-

tion.  Do not close the Reconcile Report during this process, minimize instead, and 

then continue with the steps below in CMS.

 a.  Retrieve the client file in HawkSoft CMS.

 b.  Select the policy containing a commission transaction highlighted on the 

Reconcile Report.

The policy number is on the Reconcile Report.

 c.  Click the Accounting icon on the CMS toolbar.

The Action menu opens.

 d.  Click Commission Accounting.

The Edit dialog opens. Transactions that are reconciled are identified by a 
blue R in the Action column.

 e.  Select the reconciled transaction that needs to be reviewed, and then click 

Edit.

The Edit/Add-Transaction dialog opens and is grayed out. In the lower right 
of the dialog, Reconciled is checked. A Date field and a Statement Date 

#Reconciliation_Problem_Message_Options
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field display the reconcile date and the statement date from the reconciliation 

process.

 f.  Do not make changes. Review and determine whether the transaction is a 

duplicate of the one highlighted in the Reconcile Report and listed in a pre-

vious carrier commission statement, or whether this is a different transaction. 

Knowing whether it is a duplicate or not will help you decide which option to 

choose in the list of options on the Reconciliation Problem message on the 

Reconcile Report.

 g.  Click OK.

The Edit/Add-Transaction dialog closes.

 h.  Click OK. 

The Edit dialog closes.

 3.  Repeat step 2 for all transactions highlighted on the Reconcile Report.

 4.  Click Finish.

The Reconciliation Problem message opens.

 5.  Select the appropriate option from the error message to resolve the transactions 

highlighted. See Reconciliation Problem Message Options for details of the 
options in this message. 

 6.  Click OK to complete the reconciliation.

See  Editing a Reconciled Commission Transaction for additional information.

Reconciliation problem message options
The error message has five options to choose from and reads as follows:

[# of entries] on this report have been previously reconciled.  What would you like to do with 

these entries?

 l Return to report and highlight these entries — Select to review the report for 

potential duplicate transactions. CMS automatically highlights transactions iden-

tified as potential duplicates.  

#Reconciliation_Problem_Message_Options
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 l Create new transactions — Select to create a new commission transaction on 

each policy in question, regardless of the commission transactions that are already 

reconciled on each policy.

 l Do NOT overwrite previously reconciled transactions — Select to ignore the 

potential duplicates on the reconciliation report and complete the reconciliation for 

all other checked transactions.  Choose this when the transactions on each policy in 

question are reviewed and the user determines that they are duplicate commission 

transaction(s).

If selected, this changes the amounts in the Agency Total field 
at the bottom of the Reconciliation Report when you click Finish.  
The sum of the commission from the potential duplicates,  
checked on the report, are subtracted from the Agency Total.

 l Overwrite previously reconciled transactions — Select to overwrite the com-

mission transactions that have been determined to be duplicates. CMS overwrites 

the transaction in the policy with what is in the report. This does not add new com-

mission transactions to the policy or policies in question. 

 l Return to report and uncheck this entry — Select to uncheck the potential duplic-

ates and return to the Reconciliation Report.

Related Topics
Commission Tracking Overview
Enabling Commission Tracking
Importing  Commission Statements
Correcting a Reconciled Commission Transaction
Modifying Commission Transactions During Reconciliation
Reconciling a Non-Imported Commission Statement

Commission Paid Statements
HawkSoft enables you to print a statement of commissions paid to your agency, or to your agents. This 

article covers how to create and print commission paid statements by agent, or commission paid 
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statements by agency.

 For more information, see Commission Tracking Overview.

In this topic:

Commission Paid Statements Commission Paid Statements

This task is typically performed by an Owner/Administrator, Manager, or Bookkeeper.

Required Permissions:
In order to complete this task, user permissions must be set to include:

Accounting > Commission Reports

See Setting User Permissions for more information.

Printing an agent commission paid statement

An agent commission paid statement displays a summary of the commission transactions in HawkSoft 

CMS for each agent. 

 This statement is typically generated after all commission statements have been reconciled  for a spe-

cified payroll date.  This information can be given to the agent(s) as a summary of the commissions due 

to them.

To create an agent commission paid statement

 1.  Click Accounting > Commission Report from the main CMS menu bar.

The HawkSoft Commission Accounting window opens.

 2.  Click   Print Statements.

The Statementsdialog opens.

The following options are available for summarizing the statement:

../../../../../Content/Agency Setup/Manage Agency Users/User Permissions.htm
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 l Agency Commission by Carrier – Displays commission transactions for the 
selected date(s), summarized by carrier(s).

 l Agency Commission by Office – Displays commission transactions for the 
selected date(s),  summarized by agency office.  This option is available only 

when multiple offices are entered in Agency Information Setup. 

 l Agent Commission –  Displays commission transactions for the selected 
date(s), summarized by agent.

 3.  Select Agent Commissionfrom the Summarize by drop-down list.

 4.  Select Agent Paid Date from the Filter by drop-down list.

 5.  Select Date from the Date Filter drop-down list.

 6.  Enter the agent paid date in the Date  field.

This should be the Agent Paid Date you entered when reconciling the commission 

statements with the commission transactions. 

 7.  Check the Transactions must be reconciled box.

 8.  Click OK to generate the statement.

The statement displays a list  of agents and the commission total for each.

 9.  Optional: Double- click on a line item to view details for that agent.

To view details for more than one agent, use the Ctrl key to 
select the agents, and then right-click to select Detail Report 
from Selected Entries.

To copy/export to Excel

Copy/paste statement details to Excel

You can copy the entire statement, or copy specific rows. To select multiple rows, hold 

Ctrl, and click to select line items. 

 1.  Click File>Copy Report to Clipboard.

The Choose action to perform dialog opens.
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 2.  Choose to Copy the entire table, or Copy selected row(s).

 3.  Optional: Include the header row.

 4.  Click OK.

 5.  Open a blank Excel worksheet, and then paste the statement into cell A1.

OR

Export statement to Excel

You can copy the entire statement, or copy specific rows. To select multiple rows, press 

the Ctrl key and click to select line items. 

 1.  Click File > Export in the top menu bar.

The Export Items dialog opens.

 2.  Click Browse to select a folder destination on your computer.

 3.  Make the following selections in Windows File Explorer:

 a.  Give your file a name in the Windows Explorer File name field.

 b.  Select Comma Delimited Text (*.csv) in the Windows Explorer Save as 
type drop-down.

 c.  Click Save.

 4.  Choose to Export All Items or Selected Items.

 5.  Click OK to export.

You can now open the CSV file with Excel.

To print the agent commission paid statement

To print the Commission Statement Detail for the selected agent(s) 
only, highlight the agent(s) initials on the statement prior to step 1. 

 1.  Click on the  Print Commission Statements button at the top  of the statement. 

The Print dialog opens.
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 a.  Select  the Report Type from the drop-down list.

 l Commission Statement Detail – Prints a list of commission trans-
actions, by agent.

 l Commission Summary – Prints commission totals for each agent.

 b.  Select Items to Print.

 c.  Click OK.

 2.  Select a printer, and then click Print.

 3.  Click File > Exit to close the report.

To export a statement to HawkSoft Reports

You can export commission statement details to HawkSoft Reports, which gives you more 

control over how to summarize the data.

Required Permissions:
In order to complete this task, user permissions must be set to include:

Reports > Advanced Reports

See Setting User Permissions for more information.

 1.  Select the agents you want to see commission details for.

To view details for more than one agent, use the Ctrl key to 
select multiple agents.

 2.  Right-click and select Detail Report from Selected Entries.

 3.  Click Send to CMS Reports.

A CMS statement of the selected agent(s)' commission statement details opens.

To generate a report containing all of your agent commissions, 
see Commission Reports.

../../../../../Content/Agency Setup/Manage Agency Users/User Permissions.htm
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Printing an agency commission paid statement

An Agency Commission Paid Statement displays a summary of the commission transactions that have 

been reconciled in HawkSoft CMS. This report is useful for creating a summary of commission paid to 

the agency on a per carrier basis for a specified time period.

To create an agency commission paid statement

 1.  Click Accounting > Commission Report from the main CMS menu bar.

The HawkSoft Commission Accounting window opens.

 2.  Click    Print Statements.

The Statements dialog opens. 

 3.  Select one of the following options to summarize the statement: 

 l Agency Commission by Carrier – Displays commission transactions for the 
selected date(s), summarized by carrier(s).

 l Agency Commission by Office – Displays commission transactions for the 
selected date(s),  summarized by agency office.  This option is available only 

when multiple offices are entered in Agency Information Setup. 

 4.  Select Agent Paid Date from the Filter by drop-down list.

 5.  Select a date from the Date Filter drop-down list.

 6.  Enter the Agent Paid Date in the Date field.

This should be the Agent Paid Date you entered when reconciling the commission 

statements with the commission transactions.

 7.  Check the Transactions must be reconciled box.

 8.  Click OK to run the report.

The statement report displays the summary of carriers and the commission total for 

each.

 9.   Optional: Double-click on a carrier (or Agency Office) to view the detail for that 

selection.
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To view details for more than one carrier, use the Ctrl key to 
select the carriers, and then right-click to select Detail Report 
from Selected Entries.

To copy/export to Excel

Copy/paste report details to Excel

You can copy the entire report, or copy specific rows. To select multiple rows, press the 

Ctrl, key and click to select line items. 

 1.  Click File > Copy Report to Clipboard.

The Choose action to perform dialog opens.

 2.  Choose to Copy the entire table, or Copy selected row(s).

 3.  Optional: Include the header row.

 4.  Click OK.

 5.  Open a blank Excel worksheet, and then paste the statement into cell A1.

OR

Export report to Excel

You can copy the entire report, or copy specific rows. To select multiple rows, press the 

Ctrl, key and click to select line items. 

 1.  Click File > Export in the top menu bar.

The Export Items dialog opens.

 2.  Click Browse to select a folder destination on your computer.

 3.  Make the following selections in Windows File Explorer:

 a.  Give your file a name in the Windows Explorer File name field.

 b.  Select Comma Delimited Text (*.csv) in the Windows Explorer Save as 
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type drop-down.

 c.  Click Save.

 4.  Choose to Export All Items or Selected Items.

 5.  Click OK to export.

You can now open the CSV file with Excel.

To print the agency commission paid statement

For best results, print from the initial All Agency Commission by Car-
rier screen. Printing from a specific carrier detail view is not recom-
mended because it is not formatted to fit on an 8 1/2 x 11 sheet of 
paper.

 1.  Click the Print Commission Statements  button at the top  of the report. 

This is different from the Print Statements button.

The Print dialog opens.

 2.  Select  the Report Type from the drop-down list.

 l Commission Statement Detail – Prints the commission transaction detail 
for the carrier.

 l Commission Summary – Prints the commission summary, with the totals for 
each carrier.

 3.  Select whether to Print All Items on the report or Selected Item(s).

 4.  Click OK.

 5.  Select a printer, and then click Print.

To export a statement to HawkSoft Reports

You can export commission statement details to HawkSoft Reports, which gives you more 

control over how to summarize data.
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Required Permissions:
In order to complete this task, user permissions must be set to include:

Reports > Advanced Reports

See Setting User Permissions for more information.

 1.  Select the carriers you want to see commission details for.

To view details for more than one carrier, use the Ctrl key to 
select multiple carriers.

 2.  Right-click and select Detail Report from Selected Entries.

 3.  Click Send to CMS Reports.

A CMS Report of the selected carrier(s)' commission statement details opens.

To generate a report containing all of your agency commissions,  
see Commission Reports.

Related Topics

Importing  Commission Statements
Reconciling a Non-Imported Commission Statement
Working with Commission Paid Report Data

Commission Reports
HawkSoft enables you to create a detailed report of commission transactions for a specified date 

period.

This article is intended to help you generate a Commission Report, modify the view and content of the 

report to  show the specific information needed, as well as print and/or export the final report.

../../../../../Content/Agency Setup/Manage Agency Users/User Permissions.htm
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In this topic:

Commission Reports Commission Reports

Commission Reports Commission Reports

This task is typically performed by an Owner/Administrator, Manager, or Bookkeeper.

Required Permissions:
In order to complete this task, user permissions must be set to include:

Accounting > Commission Reports
Reports > Advanced Reports

See Setting User Permissions for more information.

Creating a commission report

First generate the report, then you can filter results to get the report you need.

 1.  Click Accounting > Commission Report from the main CMS  menu bar.

 2.  Click   Report.

 3.  Choose a filter option from the Filter by drop-down list.

 l Agent Paid Date – (Recommended) Select to filter the Commission Paid Report by the 
date the agent is paid. This date is typically a payroll date for the agents.

CMS includes transactions with matching Agent Paid Date and Agent Commission 
Paid Date. These dates are entered in the Commission Reconciliation Report-State-
ment Info dialog when you reconcile commission statements.

 l Reconcile Date  (Agency Paid Date) – Select to filter the report by the commission state-
ment reconciliation date.

 l Statement Date – Select to filter the report by the commission statement date.

 4.  Select Date from the Date Filter drop-down list.

../../../../../Content/Agency Setup/Manage Agency Users/User Permissions.htm
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 5.  Enter the agent paid date in the Date  field.

This should be the Agent Paid Date you entered when reconciling the commission statements 

with the commission transactions. 

HawkSoft's recommended commissions workflow is to use the same date of 
the month for all Agent Commission Paid Dates when reconciling. If this work-
flow is followed, all reconciled commission transactions for the month in ques-
tion should appear on the Commission Paid Report when the Agent Paid 
Date is set to that specific day of the month.

For example: If you pay your agents on the 20th of every month, use the 
20th of every month as the Agent Paid Date for all future reconciliations. If 
you want to run a Commission Paid Report for all transactions in August, 
select August 20th in the report filters, and all transactions in August should 
appear on the report (assuming this reconciliation workflow is always fol-
lowed).

 6.  Click OK to run the report.

The report begins processing. Once processed, a CMS Reports window appears with a Com-

mission Detail report of reconciled transactions for the selected date. 

To view a client file for a specific transaction, double-click on the transaction.

About the CMS Reports Toolbar

Agency Intelligence
Click to access predefined Agency Intelligence 

Reports.

Sales & Retention
Click to access predefined Sales and Reten-

tion Reports. 

Advanced

Click to  create a new customized report using 

the Report Generator.  See Advanced Cus-

tomized Reports for more information.

Open

Opens the Agency Documents folder where 

your memorized and saved reports are loc-

ated. Select a report and click Open.  See 
Report Templates (Memorized) and Saved 

#Agency%20Intelligence%20Reports
#Agency%20Intelligence%20Reports
#Sales%20and%20Retention%20Reports
#Sales%20and%20Retention%20Reports
#Advanced%20Customized%20Reports
#Advanced%20Customized%20Reports
#Report%20Templates%20(Memorized)
#Saved%20Reports
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Reports for more information.

Save

Save the report to your Haw/Agency Docu-

ments folder.

This option is available for Advanced Reports  

or once you drill-down in an Agency Intel-

ligence or Sales & Retention report.

Print

Click to send the report to  the selected printer.

You must have permissions to Reports: Allow 
Printing for this option to be enabled. See Set-
ting User Permissions.

Refresh

For Agency Intelligence and Sales & Retention 

reports, this button refreshes the data to reflect 

any recent changes in your agency's database 

since the report was opened. 

Summary

Opens the Create Summary dialog to enable 
you to filter data further.

This option is available for Advanced reports, 

or once you drill-down in an Agency Intel-

ligence or Sales & Retention report.

Tutorial Click to open a brief reports tutorial.

About the Commission Detail report columns

Client ID
This client's unique ID, as found in Customer 
ID field in the top-left of the client file.

Name Client name.

Client State

The state that the client's physical address is 

located in. If the client does not have a physical 

address, the mailing address is used instead.

#Saved%20Reports
#Saved%20Reports
#Advanced%20Customized%20Reports
#Agency%20Intelligence%20Reports
#Agency%20Intelligence%20Reports
#Sales%20and%20Retention%20Reports
../../../../../Content/Agency Setup/Manage Agency Users/User Permissions.htm
../../../../../Content/Agency Setup/Manage Agency Users/User Permissions.htm
#Agency%20Intelligence%20Reports
#Sales%20and%20Retention%20Reports
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#Agency%20Intelligence%20Reports
#Sales%20and%20Retention%20Reports
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Company Carrier name.

Policy Number Policy number.

Application Type
Application type for the policy (e.g. Personal, 

Commercial, Agriculture).

Policy Title
Title of the policy. This is usually the 

ACORD standard code for the policy.

Statement Date
Statement date for the source statement. 

Format: MM/DD/YYYY

Transaction Type Type of commissionable transaction.

New/Renew
This column specifies if the policy is new or a 

renewal.

Effective Date
Effective date of the policy term. 

Format: MM/DD/YYYY

Premium Paid On Commissionable premium for the policy term.

Agency Paid Date
Date of commission payment to the agency. 

Format: MM/DD/YYYY

Agency Commission
Commissionable Amount paid to the agency, 

including commission owed to the agent(s).

Agency Commission 

%

Percent of premium paid to the agency as com-

mission. This value is calculated when running 

the report.

Agent Paid Date
Date of commission payment to the agent(s). 

Format: MM/DD/YYYY

Total Agent Com-

mission

Sum of commission paid to Agent 1, Agent 2, 

and Agent 3 on the policy. This value is cal-

culated when running the report.

Total Agent Com-

mission %

Percentage of commission paid to Agent 1, 

Agent 2, and Agent 3.
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Commission Net Rev-

enue

Amount of commission paid to the agency, less 

commission paid to the agent(s).

Agent 1 CMS Initials for Agent 1 on the policy.

Agent 1 Commission Amount of commission paid to Agent 1.

Agent 1 Commission 

%
Percent of commission paid to Agent 1.

Agent 2 CMS Initials for Agent 2 on the policy.

Agent 2 Commission Amount of commission paid to Agent 2.

Agent 2 Commission 

%
Percent of commission paid to Agent 2.

Agent 3 CMS Initials for Agent 3 on the policy.

Agent 3 Commission Amount of commission paid to Agent 3.

Agent 3 Commission 

%
Percent of commission paid to Agent 3.

Office

Agency office this policy is assigned to. This 

column will be blank for agencies that do not 

use offices.

Agent Code Agent code for the policy.

Source Source for the policy.

Billing Type Billing type for the policy.

Inception Date
Inception date for the policy. 

Format: MM/DD/YYYY

Policy Index
This policy's tab number on the client file. For 

example, 3-Home.

Modifying the report view and content
Use the following options to obtain the specific information you need from the report.
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To filter report data

You can filter the Commission Report data to show only results which match a certain field. 

 1.  Select the field to search by from the Filter drop-down, above the table of commission trans-
actions.

 2.  Type in the string to filter results by in the field to the right of the Filter drop-down.

Only commission transactions that match your designated filter will appear in the report.

Example: If we want to filter the results to only show transactions in which the client is loc-
ated in Oregon, we would choose Client State in the Filter drop-down, and then type in OR 

in the field to the right.

To rearrange columns

Click and hold your mouse over any of the column headings, and then drag and drop column headings 

horizontally to rearrange the order.

To sort by a column

To sort the column data, click the column heading.

To reverse the sort order, click the column heading again. 

To create a new report from selected entries

You can select specific entries in the report to create a sub-report of only those entries.

 1.  Press and hold the Ctrl key and select specific entries.

OR

To select a range of line items, select the first item, and then press the Shift key to select the last 
item to be included in the section. 

 2.  Right-click any of the selected entries and choose New Report from Selected Entries. 

To summarize a report
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The Summary function enables you  to summarize data by selected criteria and then further manipulate 

the summarized data.  A Report can be summarized multiple times, giving you the ability to drill-down to 

the necessary level of detail.

 1.  Click Summary on the report toolbar.

The Create Summary dialog opens.

 2.  Select a field from the Summarize list.

 3.  Optional: Select the format for the Group by options.

The Group By drop-down list is available only for date and status fields.

 4.  Click OK.

The summary lists the items by description. 

Example: When a report is summarized by 'Name', all names matching the same description are 

listed on the same line. 

 5.  Highlight the line item(s) you are searching for, and then right-click  to select New Report. 

If needed, you can use the Ctrl key to select more than one line item.

 Each time you generate a new report, a tab is created at the top of the report. 
You can click on the tabs to view the different reports.

 6.  To view a client file for a specific line item, double-click on it to open the client file.

Export report data
HawkSoft CMS enables you to export data from CMS reports. You can copy and paste data  into an 

Excel spreadsheet, or select one of the Export options available  when you click File > Export from the 
menu bar at the top of the CMS report.

Required Permissions:
In order to complete this task, user permissions must be set to include:

Reports > Output of Advanced Reports/Activity Reports > Allow Printing, Saving, 
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and Exporting of Report Data

See Setting User Permissions for more information.

Copy/Paste report data

You can copy and paste report data into a Microsoft Excel® document.

 1.  Select the line items to be copied.

Press and hold the Ctrl key and select specific entries.

OR

To select a range of line items, select the first item, and then press the Shift key to 
select the last item to be included in the section. 

 2.  Click Edit > Copy from the Report menu bar. 

The Choose action to perform dialog opens. 

 3.  Select Copy selected row(s) or Copy entire table.

 a.  Optional: If you selected the entire table, you can select  Include header row.

 4.  Click OK to copy.

 5.  Open a blank Excel document. 

 6.  Place your cursor in the first cell, and then click the Paste icon at the top of the Excel 
document. 

Export menu options

You can easily export the report using the Export menu. 

 1.  Click File > Export >Report.

The standard Windows® Save As dialog opens.

 2.  Navigate to the location where you want to save the report.

 3.  Save the report with one of the following file types: 

../../../../../Content/Agency Setup/Manage Agency Users/User Permissions.htm
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 l Text Files (*.txt) – Exports data as a text file.

 l Comma Delimited File (*csv) – Exports data in a structure that can be 
opened with any spreadsheet software you have installed on your computer, 

such as Excel®.

Print report data
HawkSoft CMS enables you to print your report using your local printer.

Formatting the  report for print

Unlike saving the report electronically, the size and content of the report is constrained by 

paper size. Therefore, before the report can be printed, the report must be formatted for 

printing to prevent truncated or omitted data.

 1.  With the report open, select File > Print Preview, and then click OK on the Enter 
Report Title dialog. 

 2.  Preview the report. 

If the report looks good, click Close, and then skip to Print the Report.

OR

If the report is cut off or missing data, you can format the report to fit your paper size, 

or change the page orientation.

Format report options

Click and drag the edges of the column headers to resize column widths. The width 

of the columns in the report window determine the width of the columns on paper.

Change page orientation

Select File > Print Setup > Landscape, and then click OK to grant more column 
space.

Print the report

#Print
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 1.  With the report open, click  Print, and then enter a report title.

 2.  Click OK.

The Print dialog opens.

 3.  Select your printer.

You can click Properties to change print options if needed. Avail-
able print properties will vary by printer and printer drivers.

 4.  Click OK.

The report is sent to the selected printer.

Related Topics

Commission Tracking Overview
Commission Paid Statements
Importing  Commission Statements
Reconciling a Non-Imported Commission Statement
Working with Commission Paid Statement Data

Creating an Agency Unpaid Commission Report
 HawkSoft CMS enables you to  create a report which includes  all of your agency's new policies that 

have commissions not yet paid. This report helps your agency to identify any missing statements or 

payments.

Required Permissions:
Typically, an Owner/Administrator or Manager creates reports. CMS does provide 
the ability to allow limited access to any user whose job responsibilities include this 
task.
Example: An agency owner may allow access to Advanced Reports,  but can limit a 
user's ability to print, export, and/or save report data.
See Setting User Permissions for more information.

In order to complete this task, user permissions must be set to include:

Reports > Advanced > Create New Reports > Run Memorized Reports

../../../../../Content/Commission Tracking/Reporting/Working with Commission Paid Statement Data CSH.htm
../../../../../Content/Agency Setup/Manage Agency Users/User Permissions.htm
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The User List permission, Output of Advanced Reports,  con-
tains a secondary permission related to the ability to print, 
export, and/or save report data.

Running a Production report to show policies with unpaid commission

 1.  Click Reports > Advanced Reports from the main CMS menu bar.

 2.  Select Production Report from the Memorized Report list.

If Production Report isn't available from your Memorized Reports list, see Custom  Reports: Step 

by Step for detailed instructions.

After you select the Production Report, the Policy Type Filter dialog opens.

 3.  Optional: Change the selected Policy Types if needed. 

 4.  Click Next.

The Report Generator Filters dialog opens with Filters set for the Production Report.

 5.  Filter 1 defaults to  the Inception Date. Modify the Date Range for policies with an Inception Date 
within a specific range.

 6.   Filter 2  defaults to the policy Status. The “Not box” is checked. This filters out the policies you 
do not want to include in the report.

 7.   For Filter 3, select Commission Filters: Reconciled  Agency Commission, and then check 
the No box to the right of the filter.

 8.  Click Next.

 9.  Click Next again to skip the additional filters.

The Report Layout opens. 

 10.  Click Next again to skip the additional filters.

The Report Layout dialog opens. 

 11.  Click Add/Edit to modify the list of output fields for your report.

 12.  Scroll to the bottom of the list, and then select the Commission check box.

This will include Agency Commission and Last Reconciled Date.

#Custom%20Reports:%20Step%20by%20Step
#Custom%20Reports:%20Step%20by%20Step
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 13.  Click OK to close the Add Report Field dialog.

The field selections are not automatically saved to this report layout. To save 
your field selections to a report layout, you must save the layout with a new 
Report Layout name.

 14.  Optional: Save the report layout.

This doesn't save the report filters, only the field layout.

 a.  Click Save Layout to save the list of Report Fields as a new Report Layout.

 b.  Enter a Layout Name, and then click OK.

 15.  Optional: Enter a Report Title if you plan to save the report results.

For example, you can save this report layout as "Unpaid Commission Report" for future access.

 16.  Click Finish.

 17.  Optional: With the report open, you can  save this report as a new Memorized Report with the Fil-

ter changes that you made. Click File > Save Memorized Report, and then give the report a 
title, such as Unpaid Commission Report. 

Next time you need to run this report, you can quickly run it from the Memorized Reports list.

The CMS Report Generator displays the results.  To modify the report view and the content, see Work-

ing with Report Data.

Related Topics

Advanced Customized Reports
Commission Tracking Overview
Custom  Reports: Step by Step
Report Templates (Memorized)
Working with Report Data

Correcting a Reconciled Commission Transaction
A reconciled commission transaction may need to be edited if a commission was reconciled with inac-

curate information, such as a wrong commission amount to an agent/the agency or a commission 

assigned to the wrong agent. 

#Report%20Templates%20(Memorized)
#Working%20with%20Report%20Data
#Working%20with%20Report%20Data
#Advanced%20Customized%20Reports
#Custom%20Reports:%20Step%20by%20Step
#Report%20Templates%20(Memorized)
#Working%20with%20Report%20Data
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HawkSoft CMS enables you to modify a reconciled commission transaction to correct any mistakes 

made during reconciliation.. This includes editing a transaction that has already been  included on a 

commission paid report. 

Internal: It is also possible to re-import an already reconciled commission state-
ment to fix the reconciled transactions on that statement. The internal section at the 
bottom of this article gives you steps to assist a customer with re-importing a recon-
ciled commission statement. However, commission transactions cannot be undone 
or manually edited en masse.

This article describes the steps to correct a commission transaction directly from a policy. Modifying a 

previously reconciled transaction will change the results of the commission paid report.

A commission transaction can also be modified on the Reconcile Report during 
reconciliation. To modify a transaction from the Reconcile Report, see Modifying 
Commission Transactions During Reconciliation.

To correct an entire commission statement that has been previously reconciled, 
contact HawkSoft Product Support.

Correcting commission transactions on a policy  is typically performed by an Owner/ Administrator, 

Manager, or Bookkeeper.

In this topic:

Editing a Reconciled Commission Trans-

action

Removing a Reconciled Commission Trans-

action

Required Permissions:
In order to complete this task, user permissions must be set to include:

Accounting > Edit Policy Commission

See Setting User Permissions for more information.

Editing a reconciled commission transaction

https://www.hawksoft.com/support/
#Editing_a_Reconciled_Commission_Transaction
#Editing_a_Reconciled_Commission_Transaction
#Removing_a_Reconciled_Commission_Transaction
#Removing_a_Reconciled_Commission_Transaction
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Editing  a commission transaction directly from a policy   is done on  the Edit/Add-Transaction dialog.  
This dialog contains the details of the commission transaction. 

 1.  Retrieve the client file, and then select the policy that the commission transaction was assigned 

to during the reconciliation.

 2.  Click Action, and then select one item in each of the first three lists to describe what prompted 

this transaction.

 3.  Select Customer Accounting. 

 4.  Select Commission Accounting.

The Commission Accounting dialog opens with the Transactions screen open. Transactions 
that are reconciled are identified by a blue R in the Action column.

 5.  Select the reconciled transaction that needs to be edited, and then click Edit.

 The Edit/Add Transaction dialog is grayed out.  In the lower right of the dialog, Reconciled is 
checked. A Date field and a Statement Date field display the reconcile date and the statement 
date from the reconciliation process.

 6.  Uncheck the Reconciled box.

A confirmation dialog appears. 

 7.  Click Yes. 

All the fields in the Edit/Add - Transaction dialog are now active. 

 8.  Modify the Edit/Add - Transaction fields as needed. 

See The Edit/Add Transaction Dialog for a description of this dialog and  fields.

 9.  Optional: Modify the (Agent) Paid Date field in the Agency Commission section of the Edit/Add - 
Transaction dialog if the commission should be paid on a different  date.  

 10.  Check the Reconciled box after modifying the Edit/Add - Transaction fields as needed. 

The Edit/Add - Transaction fields are grayed out again.

After editing is complete, the reconciled transaction appears when running a  
Commission Paid Report. 

 11.  Click OK to close the Edit/Add - Transaction dialog.

 12.  Click Finish to close the Commission Accounting dialog.

Action Menu.htm
../../../../../Content/Commission Tracking/Creating Commission Transactions/Edit Add Transaction Dialog.htm
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 13.  Click Finish to close the Action menu.

The Add Log Entry Comments dialog opens.

 14.  Add comments as needed, and then click OK.

Run the Agent or Agency Commission Paid Report  to see the modified commission transaction.

Removing a reconciled commission transaction

 1.  Retrieve the client file, and then select the policy that the commission transaction was assigned 

to during the reconciliation.

 2.  Click Action, and then select one item in each of the first three lists to describe what prompted 

this transaction.

 3.  Select Customer Accounting. 

 4.  Select Commission Accounting.

The Commission Accounting dialog opens. Transactions that are reconciled are identified by 
a blue R in the Action column.

 5.  Select the reconciled transaction that needs to be removed, and then click Remove.

A confirmation message appears.

 6.  Click Yes to verify removal of the reconciled transaction.  

 7.  The commission transaction is removed from the Transactions screen.

 8.  Click Finish to close the Commission Accounting dialog.

 9.  The removed commission transaction will not appear on a Reconcile Report or Commission Paid 

Report.

 10.  Click Finish to close the Action menu.

The Add Log Entry Comments dialog opens.

 11.  Add comments as needed, and then click OK.

Run the Agent or Agency Commission Paid Report   to see the modified commission transaction.

Related Topics

Commission Tracking Overview
             Creating Commission Transactions on a Policy

Creating a Log Note.htm
#Printing_an_Agent_Commission_Paid_Statement
#Printing_an_Agency_Commission_Paid_Statement
Action Menu.htm
Creating a Log Note.htm
#Printing_an_Agent_Commission_Paid_Statement
#Printing_an_Agency_Commission_Paid_Statement
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Creating a Reconcile Report 
Modifying Commission Transactions During Reconciliation
Overriding Commissions
Reconciling a Non-Imported Commission Statement
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